
user manual Last updated on 06/19/2024



Melodyne 5 essential - Stand-alone

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 2

The Melodyne Help Center and this PDF document

This PDF document was generated automatically from the contents of the Melodyne Help Center. It 

contains what, on the date indicated on the front page, were the latest versions of the text and 

images.

You will find the comprehensive and invariably up-to-date Melodyne Help Center along with 

numerous films and inspiring tutorials, as well naturally as the latest version of this PDF document, on 

our web site. Why not take a look? Just follow the link at the foot of each page of this PDF.

Melodyne 5 essential – Quick Start

    Integration • Checking the algorithm • Editing • The macros • What else should I read?

Melodyne expert tips

    Lead vocals • Background vocals • Guitar and bass • Other instruments and mixing • Workflows and 

techniques

Reference manual videos

   Fundamentals and workflow • Tools and functions • Algorithms and note assignment • Tempo

Installation and activation

   Procedure and terminology • What files are installed and where • Your user account • Licence options: 

   Deactivate • Checking for updates • Selling your license • Uninstalling Melodyne
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Updates and upgrades

  Terminology: major and minor updates, upgrades • Checking for updates • Information about your edition, 

  version and serial number • How updates and upgrades are performed and what the process involves • iLok 

  when updating or upgrading • Compatibility after an update or upgrade • Parallel operation of old and new 

  versions after an update or upgrade • Going back to your old Melodyne • What upgrades are available and 

what benefits do they bring

Loading and saving audio

  Tempo adjustment when audio files are loaded • Loading files from the menu • Loading files by drag ‘n’ drop

   • The File Browser • Saving audio: the Export window • The ‘Replace Audio’ command

Recording audio

  Audio and recording preferences • Handling the tempo and the metronome • Enabling, starting and stopping 

recording

The Project Browser

  Opening the Project Browser • The Project Browser in the stand-alone implementation • Unused and missing 

 audio files • Commands in the drop-down and context menus

Project documents

  Opening a project document • Creating a new project document and switching between projects • Closing 

   and saving projects • The audio folder of a project • Copying audio from one open project to another •

Importing projects

Playback, navigation, zooming

 Controlling playback using the keyboard and transport bar • Controlling playback, scrubbing and zooming 

   using the Time Ruler • Resizing the window • Scrolling and zooming in the Note Editor • Navigation and 

zoom functions

Cycle mode

  Defining the cycle range • Switching cycle mode on and off • Changing the length of, and moving, the cycle 

 range • Defining the cycle range using a blob selection

Display and other options

   Showing and hiding elements of the user interface • Show Pitch Curve • Show Note Separations •

   Displaying sibilants • Show Blob Info • Show Intended Notes • Monitor When Editing Blobs
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Preferences and keyboard shortcuts

   Opening the window and user interface settings • Audio and recording preferences • Shortcuts • Check for 

Updates

Audio characteristics and algorithms

    The detection process • The Universal algorithm • The “Percussive” algorithms • The Melodic algorithm •

  The “Polyphonic” algorithms • Switching algorithms • Automatic or manual algorithm selection

Note Assignment Mode

  What editing the detection involves • What is edited and where • Various types of notes

Tools for note assignment

  The Main Tool in Note Assignment Mode • The Activation Tool • Starting point lines and designated starting 

  points • The Note Separation Tool and the Separation Type Tool • The Starting Point Tool

The Time Grid

 Activating and setting the Time Grid • Moving notes when the grid is active

Chord recognition and the Chord Track

  Limitations of the editions Melodyne essential and assistant • Triggering the harmonic analysis • Selecting 

   between alternative designations • Entering chords manually • Keyboard shortcuts for editing the chords •

   Auditioning chords • Chord symbol conventions • MIDI export of the chords as a lead sheet • The Key Track 

  and key changes • The Key Track and the Scale Ruler • Chords and keys in Note Assignment Mode

The Pitch Grid

 The functions of the Pitch Ruler and access to the Pitch Grid • The Pitch Grid and the background in the Note 

   Editor • The Scale Ruler and the Reference Pitch Ruler • Adjusting the master tuning • Selecting the tonic 

 and scale variety • The Scale Window

Selecting notes

  Standard selection techniques • Snake selection • Selection using the Pitch Ruler
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Correct Pitch Macro

  Opening and using the macro • Closing the macro and correction values when it is reopened • The Correct 

Pitch macro and sibilants

Quantize Time Macro

 Quantizing timing: What is moved and where to? • Opening the Quantize Time Macro and setting the 

 parameters • Closing the macro and correction values on reopening

The Leveling Macro

  Opening and setting the Leveling Macro • The Mean Amplitude • Closing the macro and correction values 

when it is subsequently re-opened

Main Tool

  Modifying the pitch and timing of notes • Modifying note lengths • Editing note separations

Copying notes

 The selection, cursor and grid when copying • Tempo adjustment when copying: the Auto Stretch Switch

Tempo detection and Auto Stretch

  Introduction • Tempo in the stand-alone and plug-in implementations • Determining the tempo in the stand-

  alone implementation • Auto Stretch when importing additional audio files • Auto Stretch when notes are 

moved or copied

Switching to Melodyne studio trial mode

   Switching to trial mode • Comparing editions • Expiry of the trial period • Convinced?

Melodyne 5: Update guide

   The Melodic Algorithm with Sibilant Detection • Compatibility with Melodyne 4 • The Leveling Macro • Pitch 

  correction by double-clicking and the Correct Pitch Macro • Chord Recognition and the Chord Track • The 

 new Percussive Pitched Algorithm • Keyboard shortcuts

Already own a Melodyne?

  How does the coupon work? • What if I have already activated my Melodyne 5 essential by mistake? •

Coupons: terms and conditions of use
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Version history

    New in Version 5.4 • New in Version 5.3.1 • New in Version 5.3 • New in Version 5.2 • New in Version 5.1.1

   • New in Version 5.1 • New in Version 5.0.2 • New in Version 5.0.1

User manuals for older versions

  Melodyne studio, editor, assistant and essential 4 • Melodyne editor, assistant and essential 2 (singletrack) •

 Melodyne studio 3 • Ending support for older versions of Melodyne
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Melodyne 5 essential – Quick Start

Melodyne 5 essential is a full version of Melodyne offering you the most important Melodyne functions 

for the editing of vocal and instrument tracks.

Melodyne 5 essential gives you direct access to individual notes within your recordings, allowing you 

to edit their pitch, position and duration in an intuitive way. The quality of Melodyne’s correction of out-

of-tune notes is legendary, but you can also introduce melodic variations, create vocal arrangements, 

quantize audio, improve timing and do many other things with it as well.

Here is a quick and concise guide to getting Melodyne 5 essential up and running.

Integration

Choose File > Import Audio...; then use the file selector to navigate to the desired audio file, and open 

it. You can load audio in various uncompressed formats such as WAV and AIFF but also MP3 – or 

CAF – files as well as Apple Loops.

Melodyne 5 essential is suitable for the editing of lead vocals and monophonic instruments as well as 

drum and percussion tracks, but you can also edit entire mixes with it – using functions such as 

transpose, quantize and time-stretch.

Checking the algorithm

Melodyne’s characteristic blobs represent the notes found in your recording, which you can select, 

drag and edit using the tool provided by Melodyne essential. Before you begin, however, there is one 

thing you must check:

Based on its analysis of the audio material, Melodyne essential will have chosen to use either its 

Melodic or its Percussive algorithm. When the Percussive algorithm is used, all the notes are 

displayed in a single horizontal line; when the Melodic algorithm is used, on the other hand, the 

vertical position of the notes represents their pitch.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
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If your audio material is not displayed the way you want, you can change the algorithm by selecting 

‘Melodic’ or ‘Percussive’, as appropriate, from the Algorithm menu. Please note, however, that if you 

do this, any editing of the track you may already have done using Melodyne will be lost! That is why, 

you should always make sure that the correct algorithm has been selected before you begin editing.

Editing

In Melodyne essential, you work exclusively with Melodyne’s Main Tool, which can be used not only 

to change the pitch of notes but also their position in time and their duration as well as to split them. 

Larger Melodyne editions offer further tools with which you can alter, among other things, the vibrato, 

amplitude and formant spectrum of notes as well as their internal timing.

Using the Main Tool, you can edit notes individually or entire selections of notes simultaneously.

To change the pitch of a note:

– Click in the middle of the corresponding blob and drag it up or down. The note will move in steps of 

a semitone.

– If you hold down the Alt key as you drag, the grid will be deactivated and you will be able to move 

the note by smaller amounts (in steps of a cent).

– If it’s the right note but simply out of tune (“off key”), double-click on it and it will snap at once to the 

intended pitch.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
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To change the position in time of a note:

– Click in the middle of the corresponding blob and drag it to the left or right. When released, the note 

will snap to the nearest grid line.

– If, however, you hold down the Alt key as you drag, the grid will be deactivated and you will be able 

to position the note freely.

To change the duration of a note…

…by making it begin earlier or later: Click the left-hand side of the blob and drag it, respectively, to 

the left or right. 

…by making it end earlier or later: Click the right-hand side of the blob and drag it, respectively, to the 

left or right.

– If you hold down the Alt key as you drag, this will deactivate the grid, allowing you to position the 

beginning or end of the note freely.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
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To split a note in two:

– Position the tool at the intended split point – not on but slightly  the blob; the appearance of above

the mouse pointer will then change, and you will be able to split the note with a double click. This can 

give you greater flexibility when correcting or reshaping notes.

– The note separation that is created can be removed with a double click to reunite the two segments.

The macros

Whilst the Main Tool is used more to solve specific problems with individual notes, the macros allow 

you to edit multiple notes and even entire recordings in one go. The macros affect only the notes 

currently selected, unless none are, in which case they affect all the notes of the audio file. There are 

three macros:

Correct Pitch, which moves notes to, or towards (you decide how far), the nearest semitone. How far 

they move also depends upon how badly out of tune they were to begin with. With the second slider, 

you can rein in pitch drift within notes.

Quantize Time moves notes to or towards (you decide how far) either the intended beat or the 

nearest line of the selected grid.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
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Note Leveling allows you to make loud notes quieter, or quiet notes louder, or both. In this way, you 

can smooth out disparities in volume and give your recordings greater homogeneity. It is also the 

perfect way to optimize input to any compressor after Melodyne in the signal chain.

What else should I read?

In this tour we have covered only the points needed to get you off to a fast and successful start with 

Melodyne. But there’s plenty more to discover and to learn. Take a look at the list of topics on the left: 

In the Help Center, you will find each of these topics explained in detail as well as a wide range of 

video tutorials. You can access these any time via Melodyne’s Help menu.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
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Melodyne expert tips

Rich Crescenti is a freelance engineer who works as a Melodyne specialist for our American 

distributors, writes pro audio articles, interviews and reviews, and conducts numerous courses and 

seminars, having clocked up over 10,000 hours of classroom instruction time.

Sensho is an audio engineer, music producer and Melodyne specialist that built his career working in 

recording studios all over Los Angeles. In his work he explores and shares innovative ways for 

modern production processes.

Look over the shoulders of our experts in the following videos and watch them at work. Benefit from 

their experience, and draw fresh inspiration. They are working in each case with Melodyne 5 studio. 

Smaller editions may differ.

Lead vocals

Background vocals

Guitar and bass

Other instruments and mixing

Workflows and techniques

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
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Reference manual videos

Here you will find all the videos to accompany the Reference manual, sorted by topic. The videos are 

in English with subtitles in German, French, Spanish and Japanese. Shown here: Melodyne 5 studio, 

smaller editions may differ.

Fundamentals and workflow

Tools and functions

Algorithms and note assignment

Tempo

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
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Installation and activation

From this tour, you will learn all you need to know about installing and activating Melodyne. We begin 

with the basic procedure and the most important terms before outlining further options and details. 

From the separate tour “Updates and upgrades”, you can learn how updates and upgrades work and 

what you need to bear in mind when considering them.

Procedure and terminology

Serial number and Melodyne license: Your serial number is a multi-character string that 

corresponds to your Melodyne license. If you make the purchase in our web shop, we give you your 

serial number; if you buy it from a dealer, you will get it from them. If you obtain Melodyne essential 

as part of a bundle, whoever supplied the bundle will provide the serial number as well.

Registration and user account: Your user account is created when you first register a Melodyne 

license. To do this, simply enter the serial number. When you make the purchase from our web shop, 

that is part of the procedure. You can then register any further Melodyne licenses via your user 

account. From your user account, you can manage your Melodyne licenses, choose your newsletter 

options and download installation programs.

Installation program: When you download the installation program (whether for macOS or Windows) 

from your user account, it installs the latest versions of the stand-alone implementation of Melodyne 

as well as of all the various plug-ins.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
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Activation: In order to run Melodyne on a particular computer, the computer must first be activated 

for Melodyne. In the course of this process, Melodyne checks the validity of your license data with our 

server, so an Internet connection is required. You will be prompted to activate Melodyne the first time 

you launch the program; this only takes a few clicks and you will need your serial number. Please 

note: Unlike the deactivation process (see below), you can only activate a computer from the 

computer itself, not from your user account.

Licence, number of activations and workstations: The standard Melodyne license allows you to 

use Melodyne on  workstation only at a time. However, the license does allow you two activations, one

the second being an emergency one you can use to activate a substitute computer quickly and easily 

if, for example, your primary computer breaks down in the middle of a production.

If you wish to use Melodyne simultaneously on two or more workstations, you can purchase further 

activations, converting your standard license into a team license. If you perform an update or upgrade 

of your team license for which a charge is made, up to four workstations are included for the same 

price as a single workstation update or upgrade. For five workstations or more, special purchase 

discounts and update/upgrade conditions apply. You can find out more about these in our .web shop

What files are installed and where

The installation program you download from your user account installs the stand-alone 

implementation of Melodyne as well as all the various plug-ins. In the process, the following files are 

placed in the following locations:

Windows 10

VST 3: C:\Program Files\Common Files\VST3\Celemony\Melodyne.vst3

AAX: C:\Program Files\Common Files\Avid\Audio\Plug-ins\Melodyne.aaxplugin

Melodyne stand-alone: C:\Program Files\Celemony\Melodyne 5\Melodyne.exe

Note for Windows users: For its audio processing, Melodyne needs to be able to store temporary files 

on your hard disk and read them. For this purpose, a directory called: C:

\Users\*\Documents\Celemony\Separations is created. To avoid Windows Defender (virus protection) 

being invoked every time data is read from this directory – which would slow Melodyne down 

drastically – an exclusion from Microsoft Defender anti-virus scans is defined for this folder when 

Melodyne is installed.

macOS 10.12 (and later)

VST 3: Macintosh HD/Library/Audio/Plug-Ins/VST3/Melodyne.vst3

AAX: Macintosh HD/Library/Application Support/Avid/Audio/Plug-Ins/Melodyne.aaxplugin

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
http://www.celemony.com
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AU: Macintosh HD/Library/Audio/Plug-Ins/Components/Melodyne.component

Melodyne stand-alone: Macintosh HD/Applications/Melodyne 5/Melodyne.app

Your user account

You can access your user account via the menu of our website, the following link: www.celemony.com

 or by choosing License from Melodyne’s Help menu./login

In addition to the latest installation program for your Melodyne and your newsletter preferences, you 

will find in your user account various options for managing your license. There is the option, for 

example, of deactivating an activated computer or of transferring an activation to iLok (except with 

Melodyne essential or in the case described above of the emergency activation).

Licence options: Deactivate

Any computer that has been activated to run Melodyne can be deactivated. The activation will then be 

credited to your user account, so that it can be transferred later to a different computer.

This means that if you have no activations left in your user account but wish to use Melodyne on a 

new computer, you can simply deactivate another computer that is still active, and this will free up an 

activation to transfer to your new one. You can switch between computers like this as often as you 

like. The only restriction is the number of computers involved. If you want to switch activations 

frequently between a fairly large number of computers, we recommend using the iLok USB copy-

protection dongle (see next section).

To deactivate a computer: Log in to your user account via our website or by choosing “License” 

from Melodyne’s Help menu. If you log in via our website, you must click the “License options” button 

to get to the page with the “Deactivate” option. If you choose “License” from Melodyne’s Help menu, it 

will take you to this page directly.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
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Nice to know: The fact that you can deactivate a computer from any other computer (provided you 

first log in to your user account) is important, as it allows you to retrieve your Melodyne activation 

from a lost or stolen computer or from one that has broken down. You can only  a computer, activate

on the other hand, from the computer itself and cannot do it through your user account.

Checking for updates

Each time you launch Melodyne, it automatically checks to see whether a newer and better version of 

the program is available for download. If a new version is available, a page giving you details of it will 

open in your browser and from this you can download the new version.

If you open the “Check for Updates” page of Melodyne’s “Preferences” dialog, you can opt, if you 

prefer, to check for updates manually (which is done by clicking the “Check Now” button) rather than 

have Melodyne do this for you automatically at program launch. We recommend you to leave the 

default setting (“Automatically”) so that you never miss an important update.

Selling your license

Naturally it is possible to sell your Melodyne, but to do so you need to contact our support. Since the 

person you sell it to will require their own user account with their own access data, we will have to 

remove your serial number from your user account and also cancel any activations you may have 

transferred to iLok. Only then can the license be transferred to the purchaser.

Please note : Resale of a Melodyne license purchased by credit card from our web shop is not 

possible within three months of the date of purchase. This is to prevent possible credit card fraud.

Uninstalling Melodyne

To uninstall Melodyne under macOS, just run the program “Melodyne Uninstaller”, which you will find 

in the “Melodyne 5” folder within your “Applications” folder. Under Windows, follow the standard 

procedure for uninstalling applications.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
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Updates and upgrades

From this tour, you will learn all about updating and upgrading Melodyne. We explain the installation 

procedure, the Melodyne license and the activation of the program in the tour “Installation and 

activation”.

Terminology: major and minor updates, upgrades

Minor update: This is a free update containing bug fixes and perhaps new functions of lesser 

importance. In this case, although the version number is incremented, its first digit remains the same 

(e.g. from 5.  to 5. ).0.3 1.0

Major update: This is an update that contains significant new features and is indicated by a change 

in the first digit of the version number (e.g. from .2.1 to .0.0). These updates are not free of charge. 4 5

Exception: Melodyne essential, for which even major updates are free of charge.

Upgrade: This is a change, for which you do have to pay, from a smaller edition of Melodyne to a 

larger one with more functions (e.g. from Melodyne essential to Melodyne assistant).

An  may also contain a major . For example, an upgrade from Melodyne  to upgrade update 4 editor

Melodyne . It is not necessary to update to editor 5 before upgrading to studio 5.5 studio

Checking for updates

Each time you launch Melodyne, it checks automatically to see whether a new and improved version 

is available for download. If this is the case, a page will open in your browser giving you details and 

allowing you to download the new version.

In Melodyne’s Preferences dialog, you will find a page entitled “Check for Updates” where you can 

switch from automatic checks (the default) to manual checks triggered by clicking the “Check Now” 

button. We recommend you to leave the default setting (“Automatically”) unchanged, so you never 

miss an important update.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
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Information about your edition, version and serial number

To discover which version of which edition you have, as well as your serial number, choose Melodyne 

> “About Melodyne” from the main menu.

The name of your edition and your serial number are also displayed in your user account. There you 

will also see which basic version you have (i.e. the first digit of your version number: 4, 5 etc.) but not 

which specific update is currently installed on your computer (e.g. 5.1.0).

How updates and upgrades are performed and what the process involves

When you are notified by Melodyne’s Check for Updates function or by newsletter that an update for 

your Melodyne is available, you will always be provided with a download link for the corresponding 

installation program. If you learn of an update in some other way or if you have purchased an 

, you will find the installation program in your user account.upgrade

Every update or upgrade requires you to install the latest version of Melodyne. In the case of a free-of-

charge  update, that’s all there is to it. In the case of a  update or an upgrade, on the other minor major

hand, you will be given a new license and at the same time your old one will expire. This also means 

that your old serial number will be replaced by a new one. So Melodyne may also need to be 

reactivated after the update or upgrade.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
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When you are reactivating the program after a major update or an upgrade, your old activations will 

no longer count, because along with your new license you will receive new activations.

A tip about updates: If you are running Melodyne on more than one computer, a major update is liable 

to involve many changes to the program, some of which may also affect the sound. For this reason, 

you will probably not want to update Melodyne on the production computer until the projects you are 

working on there are complete, but you may still want to try out the new version on your laptop. This 

is not a problem: if you buy an update from Melodyne 4 to Melodyne 5, your activations for Melodyne 

4 will not be removed immediately but only after the installation of Melodyne 5. You can update 

Melodyne on one of the computers and continue to run Melodyne 4 on the other for a transitional 

period.

iLok when updating or upgrading

With iLok, too, a distinction has to be made between (on the one hand) a  update and (on the minor

other) a  update or an upgrade. In the case of a minor update, you don’t need to do anything; major

your iLok USB dongle will continue to work.

With a , however, you receive a new license, so in both these cases major update or an upgrade

your iLok license must be updated. If you are using iLok, we transfer your new licence automatically 

to your iLok account, where it replaces the old one.

At this point, action from you is required: To run your new Melodyne, you must then transfer your 

new Melodyne license from your iLok account to your iLok USB dongle.

Compatibility after an update or upgrade

An update will give you new features and possibilities, but will remain compatible with your existing 

projects. Please note, however, that we are talking here about  compatibility only: You will be upward

able to open projects saved by your old version of Melodyne in your new one, but you will not be able 

to open projects saved with your new version of Melodyne in your old one.

In the case of massive leaps, however, such as from Version 1 to Version 5, there will naturally be 

major differences, as the pace of development at Celemony is unrelenting. New processing methods 

and bug fixes, as well as new and improved functions, all find expression in higher sound quality – or, 

to put it in neutral terms, acoustic differences. For this reason, you are advised in case of doubt not to 

perform this type of major update while you are still working on a project.

Different  of the program are also compatible, provided they have the same version numbers. editions

You can, for instance, open a project created by Melodyne editor Version 5.0.1 in Melodyne essential 

Version 5.0.1 or even in Melodyne player (a non-activated Melodyne) Version 5.0.1. Everything will 

sound exactly as it did when it was saved by Melodyne editor, even if some or all of the functions you 

used to perform the edits in Melodyne editor are not available in Melodyne essential or player.
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The reason is that Melodyne editions differ from one another not in the technology they use but in the 

range of functions they provide. Since Melodyne essential offers fewer functions than Melodyne 

editor, you will be limited to these when performing any further editing in Melodyne essential of a 

Melodyne editor project, and no further editing of it at all will be possible using Melodyne player. A 

wider range of functions, on the other hand, would be available to you if you opened the same editor 

project in the more powerful Melodyne studio.

Parallel operation of old and new versions after an update or upgrade

This is impossible for technical reasons: DAWs recognize the Melodyne plug-in by its identifier, and 

this does not change when the product is upgraded or updated. The advantage is that this allows you 

to update or upgrade Melodyne in the middle of a project and continue working seamlessly. It does 

mean, however, that you cannot run your old and new versions of Melodyne in parallel inside the 

same DAW, as they would need to use the same identifier and no DAW will allow the same identifier 

to be used more than once.

Going back to your old Melodyne

After a major update or upgrade, it is usually not possible to go back to the version or edition of 

Melodyne you were using previously. However, if serious problems or incompatibilities arise in your 

system after an update or upgrade, please contact our support. We’re sure to find a solution.

What upgrades are available and what benefits do they bring

You can upgrade from any edition of Melodyne to any of the larger editions – even directly from the 

smallest, Melodyne essential, to the largest, Melodyne studio.

You will find an overview of all updates and upgrades in our web shop. Under “More Info...”, you can 

discover which key functions and features not offered by your current edition the upgrade will bring 

you.

You will find a table comparing the various editions .here
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Loading and saving audio

In this tour, you will learn how to open audio files and export audio from the stand-alone 

implementation of Melodyne.

Please note: The amount of memory Melodyne requires depends partly upon the length of the files 

you are transferring to it or loading but mainly upon the number of notes they contain: the more notes 

a file contains, the longer the detection process takes and the more memory it requires. This makes it 

difficult to formulate a concrete rule, but, in general: with files longer than an hour, the detection 

process is generally slow; files longer than two hours, however, may be impossible to load or transfer 

at all, due to shortage of memory. In such cases, please divide the file up and transfer or load only 

the segments that you actually wish to edit in Melodyne.

Tempo adjustment when audio files are loaded

When an audio file is opened, Melodyne detects not only the notes it contains but also the musical 

tempo. Whether this tempo information is used to adjust the tempo of the file depends upon the 

status of the Auto Stretch switch in the transport bar.

For details, see the tour “Tempo detection and Auto Stretch”.

Loading files from the menu

Choose File > Import Audio...; then use the file selector to navigate to the desired audio file, and open 

it.

You can load audio in various uncompressed formats such as WAV and AIFF but also MP3 – or CAF 

– files as well as Apple Loops.

Alternatively, you can load audio files by choosing File > Open from the menu bar. In this case, if you 

select more than one audio file, a separate project (with its own tab above the transport bar) will be 

created for each file.
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Loading files by drag ‘n’ drop

You can load files into Melodyne by drag ‘n’ drop from the following locations:

your operating system’s file manager (e.g. Finder or Explorer)

Melodyne’s File Browser (which displays folders on your hard disk – see below)

Melodyne’s Project Browser (which shows the audio files the project is already using) When 

dropping audio files into Melodyne, they will snap to the grid if it is active. You must therefore 

deactivate it if you wish to position the files freely, i.e. without the grid influencing the result.

Tip: It is not only audio files but also Melodyne project files (MPD files) that can be dragged and 

dropped at a desired point in the timeline, in which case Melodyne imports into the current project all 

the contents of the MPD file.

Whenever you use the drag ‘n’ drop procedure, pay attention to the status of the Auto Stretch switch, 

as this determines whether or not the imported file adopts the tempo of the project.

The File Browser

The File Browser can be displayed in the Info pane and offers you a user-friendly way of accessing 

audio file folders you use often.

Initially, the File Browser is empty. Drag the folders you wish to include from your computer’s file 

manager (e.g. Finder or Explorer) into the empty grey pane.

You can drag to the File Browser folders from different storage devices and different hierarchical 

levels within your file structure. In the Browser itself, all the folders appear at the same level in the 

form of a simple list. To the left of each entry is a small triangle that can be used to expand the folder 

in question. In this way, you can navigate down through the hierarchy of folders.
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Any time you double-click on a folder, you “plunge into it”, so to speak, and the rest of the directory 

structure in the File Browser is hidden. The pop-up button at the top of the browser displays the path 

of the current folder and allows you to ‘resurface’ (i.e. return to the highest level) and regain access to 

the hidden folders.

Audio files are displayed in the file browser with one of two symbols: a colored blob or a grey 

waveform. Those marked with a colored blob already contain tempo- or note-detection information 

and require no further analysis, so they will load especially quickly. Files marked with a gray 

waveform contain no such information.

To the right of each audio file, you will see a Play button to allow you to preview (or ‘audition’) its 

contents. The volume button for this preview function is to the right of the pop-up button displaying 

the folder name or level.

Saving audio: the Export window

To save audio material in the form of an audio file on your hard disk, choose File > Export... from the 

menu bar. This opens the Export dialog, in which you will find a variety of options.

From the top line, you select the file format, the sample rate and the bit resolution of the file(s) to be 

exported. From the second line, you select the scope (in time) of the material to be exported. Whether 

the material is exported in mono or stereo depends upon the number of channels in the original files.

For the Range (i.e. the temporal scope), the following options are available:

Entire Length: everything from the beginning of the first track to the end of the last.

Cycle Range Only: only the segment of the timeline between the cycle locators.

The “Include tails” box should be checked in cases where, for example, you have chosen Cycle 

Range Only but some notes in the selection overlap the end of the range. Selecting this option 

extends the range slightly so that the tails of notes are not chopped off and the decay is preserved.
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Click the Export button to begin the export with the selected options. A file selector will open so that 

you can choose the storage location.

The ‘Replace Audio’ command

The ‘Replace Audio’ command in the File menu allows you to save an audio file edited in Melodyne 

under its original name without recourse to the Export dialog. The original file is then replaced by the 

version edited in Melodyne, but at the same time Melodyne also saves the original file, adding “orig” 

to the filename. Access to the unedited original remains possible, therefore, at any time, as it has not 

been deleted but simply renamed.

Saving with “Replace Audio” is primarily useful when you define Melodyne in your DAW as the 

external sample editor: at the push of a button inside the DAW, you can then open a file for editing in 

Melodyne, whereby saving it subsequently with “Replace Audio” ensures that the file is “given back” 

to the DAW automatically. This is because the DAW uses the name of the file to identify and access 

it, and since Melodyne is no longer changing the name, saving the edited file in Melodyne with 

“Replace Audio” makes it instantly available to the DAW.

The advantage of defining Melodyne as a sample editor in your DAW (as opposed to using it as a 

plug-in), is that the transfer process, which with long files can be time-consuming, is replaced by a 

swifter load operation. The disadvantage is that you cannot hear your editing in the context of the 

arrangement and cannot make the audio file available once more to the DAW without “freezing” it. 

This is different from working with the Melodyne plug-in, which you can leave open until the final mix, 

making further changes at any time and hearing them in the context of the DAW arrangement.

The replacing of audio files and the saving of Melodyne project files are processes that influence one 

another. Suppose, for example, you have opened a file from the DAW in Melodyne and performed 

some editing, but think you might wish to revise this later. In this case, you should save your editing in 

a Melodyne project file (suffix “.mpd”). This .mpd file initially references the audio file provided by the 

DAW.
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If you wanted at this stage to give the edited audio file back to the DAW, the “Replace Audio” 

command, if it were available, would have unintended consequences, because Melodyne’s .mpd file 

would be referencing the newly edited version of the audio file not the original. This would mean that 

if in the course of further editing you tried to restore a note you had previously deleted, you would 

discover that this was impossible, as the note would no longer be present in the file. To avoid this 

problem, when replacing an audio file, Melodyne changes the reference in the .mpd file – whenever 

one has been created – from a reference not to the  audio file but to the original (i.e. to the file edited

with “orig” added to its name) before saving the .mpd file again. This is why the “Replace Audio” 

command disappears from the File menu whenever an .mpd file is created and “Save and Replace 

Audio” appears there instead.

This solution allows you, on the one hand, immediate access to the edited audio file in the DAW, and 

on the other, the freedom to undo, or make further, changes at any time in Melodyne simply by 

loading the .mpd file, as this retains access to the original.

Please note: The “Replace Audio” command is only available for WAV or AIF files. With compressed 

audio formats, such as .mp3 or .caf, you cannot overwrite the original; instead you must create a new 

WAV or AIF file using the “Export” command from the File menu.
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Recording audio

In this tour you will learn how to record audio with the stand-alone implementation of Melodyne and 

what has to be borne in mind when doing so.

Audio and recording preferences

Before recording for the first time in the stand-alone implementation of Melodyne, you should open 

the Preferences property sheet to examine, and if necessary change, the audio and recording 

settings.

To open the Preferences property sheet, choose Program (macOS) or File (Windows) followed in 

each case by Preferences..

On the Audio page, you will see the general audio settings. If you have already loaded, played back 

and edited files with Melodyne and everything functioned, you can just leave the existing settings. (On 

the Mac, the internal Core Audio hardware is used by default; under Windows, the ASIO driver of 

your audio hardware should be selected).

On the Recording page, you can select a file format for your recordings, such as WAV or AIFF.

Handling the tempo and the metronome

Before you begin the first recording in a new Melodyne project, you should devote some thought to 

the matter of tempo. In a new document, the tempo and time signature fields are initially empty; 

instead of a value in each case, a simple dash (“–”) is displayed. The Time Ruler, initially, is calibrated 

in seconds. At this stage, then, there is no musical tempo.
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You now have two choices: you can either enter the tempo manually and record in time to a 

metronome click or begin recording with the tempo field still empty, allowing Melodyne to detect the 

tempo automatically.

To enter the tempo manually, proceed as follows (the default values, unless others are entered by 

hand, are 120 BPM for the tempo, 4/4 for the time signature, and quarter note (crotchet) intervals for 

the Time Grid):

Enter the desired value in beats per minute (BPM) in the tempo field

Enter the desired values for the numerator and denominator of the time signature (e.g. 6/8)

Enter a musical note value instead of seconds in the menu for the Time Grid

Click on the icon between the time signature and tempo fields in the transport bar to activate 

the metronome. When you choose this procedure, Melodyne assumes that you intend the 

tempo to be constant, so any fluctuations in tempo will be revealed by a discrepancy between 

the position of the blobs and that of the grid lines. The fact that you have opted for a constant 

tempo will be indicated by an equals sign (“=”) before the tempo in the transport bar.

To activate the metronome, click on the icon between the time signature and the tempo in the 

transport bar. To make the click quieter or louder, click on the same (metronome) icon and drag 

downwards or upwards without releasing the mouse button.

If you are used to working with DAWs, you may be more comfortable setting the tempo manually and 

recording to a click. Since Melodyne is extremely good at detecting the tempo, however, it is in many 

cases easier and more practical simply to allow Melodyne’s tempo detection routines to determine the 

tempo for you.

Instead of initializing the tempo, time signature and Time Grid values manually, as just 

described, begin recording with the tempo and time signature fields empty. Now you no longer 

need a click to listen to as you record because Melodyne will detect the tempo and tempo 

fluctuations within the recording and adjust the grid lines and subsequent click accordingly. 

Instead of entering a numerical value for the tempo, in other words, you are determining the 

tempo through your performance.

This will result in any fluctuations in tempo within the performance being considered deliberate and 

the tempo being interpreted as variable. The value in the tempo field will therefore be constantly 

changing in the course of playback, and the mesh of the Time Grid will expand or contract 

accordingly (i.e. distance between grid lines will increase or decrease) as the tempo changes. The 
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fact that the tempo is variable is indicated by the presence of a tilde (“~”) before the value in the 

tempo field.

Enabling, starting and stopping recording

Move the playback cursor to a point just to the left of that at which you intend to begin 

recording. This will give you a cue.

Click on the record button in the transport bar, to activate Melodyne’s record mode.

Begin the actual recording by clicking the play button and commence recording.

The cycle range can also be used during a recording to play back a specific segment of the track 

repeatedly. The recording, however, ignores the cycle and appears on your track as though the cycle 

were inactive.

By clicking on the record button in the transport bar as the playback proceeds, you can punch in and 

out (i.e. toggle record mode on and off). When you halt the playback in Melodyne, all recording 

ceases.

You can discard a poor recording simply by choosing Undo. You can listen to a recording even while 

the detection process is underway and cancel if you wish.
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The Project Browser

The Project Browser shows you all the audio files used by each project and helps you manage them 

and locate missing files.

Opening the Project Browser

Both the stand-alone implementation and the plug-in possess a Project Browser. In each case, this is 

opened by choosing “Show Info Pane” from the Options menu.

The Project Browser in the stand-alone implementation

In the stand-alone implementation of Melodyne, the Project Browser displays all the audio files that 

you have integrated into the project – whether via the File menu, by dragging and dropping, or by 

recording. If you click a blob in the Note Editor, the Project Browser will highlight the audio file to 

which the note in question belongs.

You can drag and drop files from the Project Browser into the project in the same way as from the 

File Browser. You might do this, for example, when you wish to use the same file in several different 

places within the project.

Please note that the Auto Stretch Switch also governs the dragging of files from the Project Browser: 

if Auto Stretch is switched on, the tempo of the file will be adjusted to that of the project; if it is 

switched off, the inserted file will retain its original tempo.
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Unused and missing audio files

In both the stand-alone implementation and the plug-in, audio files are color-coded in the browser as 

follows:

Black: The file is present and being used by the project

Gray: The file is present but not in use (e.g. because you have deleted from the project all the 

notes it contains)

Red: The file is needed but unavailable

The reason unused files are retained in the Project Browser rather than being deleted automatically is 

that this allows you to undo the delete operation, which would otherwise be impossible.

If Melodyne cannot find one of the files it needs to use – either because it has been deleted or 

because it was not moved to a new computer along with the other project files – the missing file will 

be shown in red in the Project Browser. The notes belonging to such a file are shown in gray with a 

red outline in the Note Editor and are muted during playback.

Commands in the drop-down and context menus

The drop-down menu opened by the cog icon in the Project Browser as well as the context menu in 

the same browser offer the following commands, some of which are designed to facilitate the 

assignment of missing files.

Set Path for Transfers... (only in the plug-in): This allows you to specify where the transfer files 

should be stored, as is explained above.

Show in Finder/Explorer: If you choose this command after right-clicking on a file in the Project 

Browser, a Finder/Explorer window will open showing you the location of the file.

Copy File(s): This copies the selected file(s) onto the clipboard. This might be useful, for example, if 

you have passed on to another user a project missing one or more of the requisite transfer files; by 

selecting the missing file(s) in the Project Browser, choosing Copy File(s) and then pasting the 

contents of the clipboard onto a hard disk or other storage medium, you can remedy the error swiftly 

without having to hunt around for the missing file(s).

Copy Path for File(s): This copies as text to the clipboard the path of the selected files. This is useful 

if you need to send someone a list of missing files.
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Find Missing Files: This opens a file selection window that allows you to locate the missing file on 

your hard disk and “show” it to Melodyne.

It is advisable to save your project after reassigning files, in order to store the updated references.

Copy External Files to Project Folder (only in the stand-alone implementation): This command 

results in all the files that you have imported into your project from different locations on your hard 

disk, whether via the File menu or by drag ‘n’ drop, being copied into the audio folder of your 

Melodyne project. This folder, which is created when your Melodyne project is first saved, is on the 

same level in the file hierarchy, and bears the same name, as the MPD file of the project, but with the 

suffix “_Audio”. It is advisable to save your DAW project after executing this command, in order to 

store the updated references.

Delete Unused Files in Project Folder: If you are certain that you will have no further need for files 

marked as unused in the Project Browser, this command allows you to delete them and liberate 

space on your hard disk.

The last two commands in the context menu allow you to specify whether the files in the Project 

Browser should be displayed in alphabetical order or according to status (missing, used, unused).
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Project documents

In the stand-alone implementation of Melodyne, you store your projects as MPD documents. You can 

open and work on several projects at the same time.

Opening a project document

As soon as you launch the stand-alone implementation of Melodyne, a new empty project is created. 

To load an existing project, choose File > Open from the menu bar. The Open Recent command 

offers you swift access to the documents opened most recently.

Melodyne’s project documents have the suffix “.mpd”.

Creating a new project document and switching between projects

Choose File > New to create a new empty project.

Melodyne allows you to work on several projects at the same time. It is therefore unnecessary to 

close the current project before opening another or creating a new one. Each open project is 

represented by a tab just below the menu bar at the top left of the screen. Tabs are only displayed 

when more than one project is open.

To switch to another project, simply click on the corresponding tab.

Closing and saving projects

To close a project, either choose File > Close or use the keyboard shortcut [Command]+W. Provided 

more than one project is open at the time, you can also close a project by clicking on the ‘x’ symbol to 
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the left of the project name on the tab. If a project contains unsaved changes, an asterisk is displayed 

beside the project name on the tab.

If you attempt to close a project containing unsaved changes, you will be offered the choice of saving 

your changes and closing the project (Save), closing the project without saving your changes 

(Discard) or returning to the open project (Cancel). The same dialog box is displayed whenever you 

attempt to quit Melodyne while a document with unsaved changes is open.

With the commands Save and Save As... in the File menu, you can save a project at any time, under 

its existing name or a new name, respectively.

The command Revert to Version Last Saved has the effect of restoring a project to the state it was in 

when last saved i.e. of discarding all the changes you have made in the interim.

The audio folder of a project

When you save a project for the first time, as well as the project’s MPD file, Melodyne creates at the 

same level in the directory hierarchy, a folder for the project’s audio files. This has the same name as 

the project but with the suffix “_Audio”.

All the recordings you have made within the project and all the samples you have imported using the 

Project Browser are stored in this folder.

If you wish to archive a project or pass it on to another user, you must archive or pass on not only its 

MPD file but also this audio folder.

Copying audio from one open project to another

Whenever more than one project is open in Melodyne, you can copy individual notes or an entire 

audio source from one project to another. Simply select the audio material, copy it, switch projects, 

and paste.

It is also possible to drag an audio file from the Project Browser of one project to the tab of another. 

As you drag the file over the tab, pause to allow Melodyne time to switch projects, before dropping 

the file at the desired location within the destination project.

Importing projects

You can import the contents of one project into the current project by dragging its MPD file from your 

computer’s Finder/Explorer or Melodyne’s File Browser.

If you select several MPD files in Melodyne’s Open dialog, these will be loaded simultaneously as 

separate projects, each with its own tab.
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Playback, navigation, zooming

This tour will give you an overview of the functions Melodyne offers for navigation and the playing 

back of audio.

Controlling playback using the keyboard and transport bar

The plug-in implementation of Melodyne is integrated into the DAW and keeps perfectly in step with 

its playback. When you reposition the DAW, this information is conveyed to Melodyne, which mirrors 

the new position. As soon as the DAW starts, Melodyne also starts. It is not possible to start, stop or 

reposition the DAW’s playback cursor from within Melodyne.

With the stand-alone implementation of Melodyne, you start and stop the playback using the buttons 

in the transport bar at the top or by pressing the space bar. If you hold the [Alt] key at the same time, 

playback will be confined to the current selection.

You can also control playback in Melodyne Stand-Alone using the numeric keypad of your computer. 

The shortcuts can be selected from the Preferences dialog, the default settings being as follows:

Playback/Pause [space bar]: Stop or Start playback from the current position of the playback 

cursor

Start [Enter] when stopped: Commence playback from the current position of the playback 

cursor

Start [Enter] during playback: Jump to, and continue playback from, the last starting point

Stop [0 on the numeric keypad] during playback: Stop and jump to the last starting point

Stop [0 on the numeric keypad] twice in succession: Jump to the beginning of the project

In both the stand-alone and plug-in implementations of Melodyne, the arrow keys on the keyboard 

can be used to step through the blobs. When playback is stopped, the blob currently selected will 

sound.

Please note that you can define a wide variety of keyboard shortcuts – including new playback 

shortcuts – using Melodyne’s Preferences dialog. If for any reason you are not satisfied with the 

default shortcuts, you can redefine them at will.

Controlling playback, scrubbing and zooming using the Time Ruler

The following playback functions are available in both the stand-alone and plug-in implementations of 

Melodyne – in the Melodyne plug-in, however, only when the DAW is stopped; as soon as it starts 
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again, Melodyne plug-in resumes its shadowing of the DAW as described earlier.

 

Double-click in the Melodyne Time Ruler (or directly in the background of the Note Editor) to 

commence playback from the position in question. If you hold down the [Alt] key as you double-click 

in the Time Ruler, playback will be confined to the current selection.

If you double-click again in the Time Ruler while the playback is in progress, the playback will stop 

and the playback cursor will move to the point clicked.

A single click in the Time Ruler moves the playback cursor to the point clicked. If you do this while 

playback is in progress, instead of halting, playback skips to the position clicked and continues from 

there. If you do it while playback is halted, the playback cursor moves to the position clicked but 

playback remains halted and only resumes if you double-click in the Time Ruler.

When playback is halted, you can scrub through the audio material by clicking and dragging in the 

Time Ruler.

By dragging upwards or downwards, you can zoom the display at the current position. Scrubbing and 

zooming can be used in combination, allowing you to navigate and position the cursor intuitively, 

setting the zoom factor at the same time.

Resizing the window

To change the size of the window, click and drag the bottom right-hand corner. The procedure is the 

same for both the stand-alone and plug-in implementations of Melodyne.
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Scrolling and zooming in the Note Editor

Select the Scroll Tool (the hand icon) from beneath the main tool or hold down the [Command] and 

[Shift] keys to move the display area with the mouse.

Select the Zoom Tool (the magnifying glass) from beneath the Main Tool or press [Command]+[Alt] to 

zoom the display with the mouse. You can zoom horizontally and vertically at the same time – with 

different levels of intensity in each case.

[Command]+[Shift]+double-click zooms in on one blob or several (if several are selected). A 

corresponding double-click in the editing background returns you to the previous zoom level.

If your hardware supports the corresponding functions, you can also scroll and zoom with the mouse 

and trackpad:

The mouse wheel and swiping with two fingers on the trackpad can be used for horizontal and 

vertical scrolling.

Pinching with two fingers on the trackpad zooms the display simultaneously on the horizontal 

and vertical planes.

Drag the horizontal or vertical scrollers (i.e. the scroll boxes or ‘thumbs’)  to move the display. The 

horizontal scroller contains a miniaturized image of the contents as an orientation aid.
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Drag the ends of the scroller to zoom the display.

If you are editing a particularly long audio file, you may find the reduced size of the scroller makes it 

difficult to achieve the desired zoom resolution. In that case, you can zoom in further by holding down 

the [Command] and [Alt] keys whilst dragging in the edit pane or else by dragging vertically in the 

Time Ruler.

If you pull one end of the horizontal or vertical slider as far as it will go and hold it, you can increase 

the vertical or horizontal size of the area displayed. This can be useful in the plug-in, for example, 

when you have only transferred the first three bars (measures) of your material but wish to insert 

something at bar 20.

Double-click in the center of the scroller to zoom in or out just enough to ensure that all the blobs are 

displayed. If cycle mode is active, double-clicking on the horizontal scroller zooms the display just 

enough to ensure that the entire contents of the cycle range are visible.

Use the slider in the bottom right-hand corner near the Note Editor to alter the height of the blobs. 

This does not alter their volume. Your likely motive will be to obtain a clearer view of material 

containing a lot of particularly quiet or particularly loud notes.

A note about automatic scrolling in the Note Editor

If you have selected one or several notes, Melodyne assumes that you wish to see and edit them, 

and exercises the requisite restraint by deactivating the auto-scroll function temporarily. Only when 

you deselect the notes (for example, by clicking in the background of the Note Editor) and restart the 

playback does the display resume its pursuit of the playback cursor.

Similarly, if you move the horizontal scroller so far during playback that the playback cursor actually 

disappears from the screen, automatic scrolling will be deactivated. Stopping and restarting in this 

case will reactivate the auto-scroll function.

If automatic scrolling has temporarily been deactivated, the auto-scroll icon in the bottom right-hand 

corner of the Note Editor takes the form shown here.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
http://www.celemony.com


Melodyne 5 essential - Stand-alone

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 39

Navigation and zoom functions

To resize the window (also in Plugin), drag the bottom right corner

Hold down the [Command]+[Shift] keys and drag the editing background of the Note Editor to 

move the area displayed

Use the mouse wheel to scroll up and down or else (holding the [Shift] key) left and right

A two-finger swipe on the trackpad can be used to scroll the display

A two-finger pinch on the trackpad can be used to zoom the display.

[Command]+[Alt]+drag in the Note Editor serves to zoom the display horizontally and/or 

vertically

Drag vertically in the Time Ruler to zoom in on the area indicated

Press [Command]+[Alt] and use the mouse wheel to zoom both axes simultaneously

Press [Command]+[Alt] and double-click to zoom in on a blob or the current selection of blobs

Press [Command]+[Alt] and double-click in the editing background to restore the previous 

zoom setting

Drag the scrollers to move the display horizontally or vertically

Drag the ends of the scroller to zoom the display horizontally or vertically

Pull the left- or right-hand ends of the horizontal slider as far as they will go to increase the 

length of the section displayed (important in the plug-in e.g. when you have only transferred 

the first four bars and  are able to navigate only in this area but wish to insert something at bar 

20)

Double-click the scrollers to zoom in or out horizontally or vertically until all notes are displayed

The slider in the bottom right-hand corner governs the height of the blobs
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Cycle mode

In Melodyne’s cycle mode, a selected passage is repeated endlessly.

Defining the cycle range

To define a cycle range, click and drag in the lower part of the Time Ruler. If, as you do so, you hold 

down the [Alt] key, the Time Grid will be ignored, allowing you to position the start and end points 

(which we call the “cycle locators”) freely.

Switching cycle mode on and off

Double-click on the cycle range in the narrow strip immediately below the Time Ruler to toggle cycle 

mode on and off. When cycle mode is active, the cycle range is shown in dark grey

In the stand-alone implementation of Melodyne, you can also switch cycle mode on and off from the 

transport bar.

It is also possible by choosing File > Preferences > Shortcuts to define a keyboard shortcut for 

toggling cycle mode on and off.

Changing the length of, and moving, the cycle range

Drag the right- or left-hand locators to alter the length of the cycle range. If, as you do so, you hold 

down the [Alt] key, the Time Grid will be ignored, allowing you to position the locators freely.
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Drag the middle of the cycle range to move it ‘en bloc’ to the left or right. If, as you do so, you hold 

down the [Alt] key, the Time Grid will be ignored.

If you [Shift]+click near either of the cycle locators, it will move to the designated position. If, as you 

do so, you hold down the [Alt] key, the Time Grid will be ignored.

Defining the cycle range using a blob selection

To move the cycle locators to the beginning and end of the current blob selection (snapping to the 

grid) hold the [Shift] key and double-click anywhere in the cycle range. If you hold the [Alt] key as well 

as the [Shift] key as you do this, instead of snapping to the grid, the locators will be placed at the 

beginning of the first, and end of the last, blob in the selection.
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Display and other options

Melodyne offers for the user interface and working in the Note Editor various options that allow you to 

adapt the appearance and behavior of the program to your tastes.

Showing and hiding elements of the user interface

Melodyne’s user interface can be adapted to a variety of different work situations and demands. You 

will find the means of doing so in the Options menu as well as the interface itself.

The illustration shows which icons in the user interface of the stand-alone implementation of 

Melodyne correspond to which items in the Options menu.

Note Editor (A): Various options for the Note Editor that are described in detail below.

Scale Editor (B): Shows/Hides successively one, two or all three panes of the Scale Editor 

window.
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Pitch Grid (C): Offers the choice between various options for the Pitch Grid.

Time Grid (D): Offers the choice between various options for the Time Grid.

Show Info Pane (E): Hides the info pane or shows it on the left- and/or right-hand side of the 

screen.

With the “Keys” (F) and “Chords” (G) switches, you can show or hide the Key and/or Chord 

tracks.

Automatic Scroll in the Note Editor (H): When this option is selected, the display in the Note 

Editor follows the playback cursor.

A note about automatic scrolling in the Note Editor: If you have selected one or several notes, 

Melodyne assumes that you wish to see and edit them, and exercises the requisite restraint by 

deactivating the auto-scroll function temporarily. Only when you deselect the notes (for example, by 

clicking in the background of the Note Editor) and restart the playback does the display resume its 

pursuit of the playback cursor.

Similarly, if you move the horizontal scroller so far during playback that the playback cursor actually 

disappears from the screen, automatic scrolling will be deactivated. Stopping and restarting in this 

case will reactivate the auto-scroll function.

If automatic scrolling has temporarily been deactivated, the auto-scroll icon in the bottom right-hand 

corner of the Note Editor takes the form shown here.

All the options described below relate to the Note Editor and are found by choosing Options > Note 

Editor Options from the main menu or by clicking the cog icon in the top right-hand corner of the Note 

Editor.

Please note that these options can be selected independently for Edit and Note Assignment modes.

Show Pitch Curve

If you check the option Show Pitch Curve, a thin line tracing the exact pitch of the tone at each instant 

will be superimposed on the corresponding blob.

On the left, you can see the ‘naked’ blobs (with none of the Note Editor display options selected) and 

on the right, the same blobs with the Show Pitch Curve option checked.
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Regardless of whether or not this option is checked, the pitch curve will be displayed whenever the 

Pitch Tool is selected.

Show Note Separations

If you select the option Show Note Separations, gray vertical lines appear at the beginnings and 

endings of notes indicating their limits or separations.

Note Separations are either shown as lines (soft separations between connected notes) or thin 

brackets (hard separations).

Note separations are always displayed when the independent Note Separation Tool is in use, 

regardless of whether or not the menu entry is checked.

Displaying sibilants

If you check the option “Show Sibilants”, the presence of sibilants (usually “s” sounds or breath noise) 

is indicated by hatching.
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Show Blob Info

With the option Show Blob Info, you can elect to show or hide a variety of display elements designed 

to facilitate working with individual notes.

The most striking of these elements is the Local Pitch Ruler that appears directly in front of any note 

over which you move the mouse pointer. Within the blob itself, thin lines mark the drag zones for the 

context-sensitive tools.

If you drag a blob when the Show Blob Info option is checked, a vertical line also appears in the Time 

Ruler aligned with the exact start of the note. This makes more precise positioning possible.

Show Intended Notes

If you check the option Show Intended Notes, gray frames appear around each blob.
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These invariably lie directly on the semitone and coincide exactly with a gridline. They represent, in 

other words, Melodyne’s assumptions (based on its own analysis of the audio) as to the intended 

pitch of the note and its intended position within the measure or bar. These assumptions generally 

turn out to be correct, but are not inevitably so. They are to be thought of as suggestions.

The frames also display the positions in pitch and time towards which the notes in question will 

gravitate if partial quantization is applied to them with the macros, which are also the positions they 

will snap to if you double-click on them with the Time Tool or Pitch Tool.

Monitor When Editing Blobs

When you shift the pitch of blobs in the Note Editor with this option selected, Melodyne plays for the 

purpose of orientation the sound of the note at the position originally clicked. You can turn this 

acoustic feedback on or off.
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Preferences and keyboard shortcuts

From the Preferences property sheet, you can select fundamental options governing the modus 

operandi of Melodyne as well as define a number of keyboard shortcuts.

Opening the window and user interface settings

In the plug-in implementation of Melodyne, you open the Preferences property sheet from the 

Settings menu; in the stand-alone implementation, choose Preferences from the program (macOS) or 

File (Windows) menu. The settings available in the stand-alone implementation differ slightly from 

those offered by the plug-in.

The following user interface options, however, are available in both implementations of Melodyne. 

Any changes you make in either implementation apply to both.

Language: Determines the language of the user interface.

Pitch labels: Determines which system is used to name the notes – i.e. (descending 

chromatically) English (C, B, Bb etc.), German (C, H, B etc.) or Latin (Do, Si, Sib etc.).

Chord spelling: Here you can choose the spelling convention used on the Chord Track.

Appearance: Here you can select between different contrast settings for the user interface.

Default tuning: Determines the default frequency of the reference pitch A4 for newly created 

documents.

Maximum undo levels: Melodyne allows you to undo up to 100 actions. The default value, 

however, is 25. You can, if you wish, increase this value, which will consume more RAM, or 

you may prefer to reduce it, if memory is running short.

Show tooltips: Once you are thoroughly familiar with Melodyne, you may prefer to hide the 

tooltips, i.e. the explanatory text that appears as you move the cursor over the various icons 

and other elements of the user interface.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
http://www.celemony.com


Melodyne 5 essential - Stand-alone

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 48

Audio and recording preferences

In both the stand-alone implementation and the plug-in, you will find the following two options:

Audio cache: Shows the location on your hard disk of the audio cache Melodyne requires for 

internal processing.

Audio cache size: Determines the maximum size of this cache.

The audio cache is used to store files Melodyne needs temporarily for its work. The size of the files 

generated depends on the audio files being processed as well as upon the algorithm Melodyne is 

using for the detection.

If these files are deleted and the Melodyne project that created and was using them is later opened 

again, they have to be recreated, which, obviously, means it takes a little longer to open the project. 

If, on the other hand, the files are still available, Melodyne will just carry on using them as before.

You can adjust the size of the cache. If, when the program is next opened, the cache is full, Melodyne 

frees up space automatically for fresh data.

Please note: The location of the audio cache is predetermined and cannot be altered:

 C:\Users\USERNAME\Documents\Celemony\Separations.Windows:

 /Users/USERNAME/Library/Caches/com.celemony.Melodyne/SeparationsmacOS:

The following option is only found in the plug-in:

Detect audio after transfer: When this option is selected, the detection (analysis) of the audio 

material does not begin until the transfer is complete, thereby reducing the CPU load during 

the transfer. Select this option if your computer is not especially powerful and there are 

indications during the transfer that its resources are becoming overstretched (e.g. clicks, drop 

outs, extreme slowing-down of the system).

The Audio and Recording pages of the Preferences property sheet display the following additional 

options:
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Audio device: allows you to select an audio driver or the audio hardware driven by it.

Sample rate: determines the sample rate used by Melodyne.

Buffer size: determines the size of the buffer used for audio editing. The smaller the value, the 

lower the latency but the greater the load on the CPU.

Ignore buffer underruns: If Melodyne Stand-Alone is running on a slow computer where the 

possibility of an overload (and an ensuing click or dropout) exists, by checking this box, you 

inform Melodyne that you consider the former to be the lesser of the two evils – the point being 

that audio hardware is often very sensitive to dropouts and can even in such cases cause the 

entire computer to crash. Check the box if ever this happens. Such occurrences are very rare, 

however, and most users can safely ignore this option.

Master output: selects the main output for Melodyne stand-alone. The level at this output is 

controlled by the Master Volume control in the transport bar. If your audio hardware only offers 

one output, this is automatically the Master output

Default input: selects the main input for Melodyne Stand-Alone. If your audio hardware only 

offers one input, this is automatically the Default input.

Audio file format: determines the file format used by Melodyne to store recordings. The most 

commonly used formats are WAV and AIFF.

Shortcuts

From the “Shortcuts” page, you can assign keyboard shortcuts to a large number of Melodyne 

functions and commands. The functions and commands in question are grouped according to 

category; click on the triangle alongside a given category to see a list of all the functions it includes. 

The following screenshot, for example, shows all the commands associated with the editing tools.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
http://www.celemony.com


Melodyne 5 essential - Stand-alone

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 50

Click on a command (“Pitch Modulation Tool” in our example) and then press the key or key 

combination you wish to assign to it. Melodyne will remember your choice, so any time you press the 

key or combination in question, this will activate the Pitch Modulation Tool. Repeat the procedure for 

as many commands as you like.

To the right of each key combination assigned, you will see an “x”. If you click on this, you can choose 

one of the following functions:

“Delete”: This cancels the assignment, so it will no longer be possible to invoke the command 

in question using a shortcut.
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“Melodyne 5”: This restores the default shortcut for the command in question. (In the case of 

many commands – namely those for which there  no default shortcut – choosing “Melodyne is

5” here will have the same effect as choosing “Delete”).

As an alternative to opening and closing the categories and scrolling through list of commands, you 

can find the command you’re looking for by typing in the  search box. This rapidly narrows left-hand

the choice and can save time. You don’t have to type the entire name of the command; just typing 

“Modulation”, for instance, throws up two search results:

If you change your mind, just click on the “x” in the left-hand search box and the original list will be 

restored in its entirety.

As well as searching by command or function name, you can search for the keys or key combinations 

already assigned; you do this using the  search box. Here, too, an incomplete entry can right-hand

yield multiple search results, which is very helpful in practice.
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For example, suppose you wish to assign a keyboard shortcut to the command that activates the 

Pitch Modulation Tool. In that case, [M] (i.e. the “M” key on its own, standing here for ‘modulation’) 

would appear to be the obvious choice; or, if that key’s already taken, perhaps [Shift] [M]. [M] or [Cmd]

To find out, just type “m” in the right-hand search box, and you will see what your options are:

[M] on its own, as you see, has already been assigned, but the combinations [Alt] [M] [M] and [Shift]

are still available.

You could also combine both fields, like this, for example:

This makes it child’s play to find a suitable shortcut. And, naturally, in our example, you could still opt 

for [M], even though it’s assigned by default to another function; it appears in your filtered list to make 

it easy for you to reassign it, if you choose to do so.

You can save your preferred shortcut assignments as a set and also load custom-designed sets, 

such as those recommended for particular DAWs. To manage all such sets, use the gear/cog menu 

at the top left.
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“… edited”: This shows you which set of shortcuts you are currently using. If it says “Cubase”, 

for example, and nothing more, this means that the set of shortcuts currently loaded is the one 

designed for the Steinberg DAW of that name and that you have not yet modified it in any way. 

If, on the other hand, it said “Cubase (edited)”, this would indicate that, after loading the set 

designed for Cubase, you had made certain changes of your own. In such cases, you might 

wish to save the set under a new name (see below).

“Melodyne 5”: Click here to load the factory default shortcuts for  commands and functions. If all

you do this, any unsaved assignments of your own will be lost.

“Open” and “Save”: These commands allow you to load an existing set of shortcuts or save the 

changes you have made to the hard disk. By saving your preferred shortcut assignments, you 

can take them with you when you change studio and load them into Melodyne there.

When you use the Save function, Melodyne suggests you store your shortcuts in the following folder:

macOS:

/Users/Shared/Library/Application Support/Celemony/Shortcuts/Melodyne5

Windows:

C:\ProgrammData\CelemonySoftwareGmbH\Shortcuts\Melodyne5

The advantage of storing your shortcuts in the folder suggested (give them a name such as 

“MyShortcuts”) is that they will then appear in the list and be readily to hand at all times.

If, on the other hand, you’re travelling to a different studio where you will be working on a different 

computer, you should simply ignore the folder suggested and save your shortcuts to some other 

location, such as a USB stick or your Dropbox folder.

Check for Updates

On this page, you can determine whether Melodyne checks for updates automatically or manually i.e. 

only when you click the ‘Check Now’ button, which you can do at any time.
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Audio characteristics and algorithms

For the display and editing of different types of audio material, Melodyne employs different 

algorithms. Here, we outline which algorithms are available and for which types of audio material 

each is used.

The detection process

Melodyne analyzes the audio material to find the notes it contains and offer them to you for editing. 

We call this process “detection”.

In the course of the detection process, Melodyne itself takes a view as to what kind of material it is 

confronted with and decides which algorithm to use for the display and playback of the notes. You 

can tell which algorithm is selected at any given time by the check mark in the Algorithm menu as well 

as by the blobs in the Note Editor.

A brief overview: Which algorithm for which type of material?

To obtain the most suitable and detailed editing possibilities, for the following sound sources, the 

following algorithms are generally used:

Singing, speech, saxophone, flute, monophonic bass etc.: "Melodic"

Drum and percussion sounds or loops, and other percussive sounds with no significant pitched 

components: "Percussive"

808-kicks and -toms, tabla and similar percussive sounds with a pitched component: 

"Percussive Pitched"

Polyphonic instruments of all kinds, loops featuring multiple instruments, and complete mixes, 

that you wish to time-stretch, quantize or transpose: "Universal"

The Universal algorithm

The Universal algorithm is particularly suitable for complex signals containing both percussive and 

tonal elements. If, for example, you wish to alter the pitch, timing or tempo of an entire piece of music, 

this algorithm will deliver the best sound quality.

The Universal algorithm, like the Percussive one, displays all the detected notes at the same pitch. 

The Pitch Ruler displays no note names, merely relative values for the semitones, and the scale 

functions are deactivated. Please note that “Universal” is never used automatically for the detection; it 

must be selected manually if required.
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The “Percussive” algorithms

The  algorithms are suitable for recordings of drums and other percussion instruments "Percussive"

but also noise and atmospheric effects as well as other material in which Melodyne cannot detect any 

clear pitch in the sounds. In this case, successive drum strokes (for example) are distinguished, but 

they are all displayed at the same pitch. The blobs can still be raised or lowered, however the Pitch 

Ruler does not display the names of any notes but simply relative values in semitones. The scale 

functions are deactivated.

Some percussion instruments, however,  have what can be understood as a melodic capability, in do

that many of their sounds have a perceived pitch. Certain 808 kick drums, for example, are clearly 

tuned to the bass. The berimbau, too, for all the percussive character of its sound, plays recognizable 

melodies – as does the tabla. It is for such instruments – instruments that are in fact percussive yet 

still somehow also melodic – that the  algorithm is intended. Here the detected "Percussive Pitched"

sounds are separated and assigned to individual pitches. This makes it easy to adjust the tuning of an 

808 kick drum, berimbau or tabla to the piece of music in question.
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Whilst the Percussive and Universal algorithms are similar in terms of the way the blobs are handled 

and displayed – just as the Percussive Pitched and Melodic algorithms seem similar at first sight – the 

two percussive algorithms in fact operate in a different way internally from their optical “twins”, as they 

are optimized for various aspects of percussive sounds and consequently deliver their most 

convincing sound quality when dealing with material of a predominantly percussive nature. When 

dealing with non-percussive sources, however, such as the human voice, guitars, pianos and so forth, 

they are at a distinct disadvantage compared with the other algorithms, which are optimized for 

sounds with a distinct pitch.

In case of doubt – with instruments seeming to fall (or perhaps alternate) between the stools 

“percussive” and “melodic” – the best policy is to try each algorithm in turn.

The Melodic algorithm

Melodic material is monophonic, by which we mean it is such that only one note is ever sounding at 

any given instant. Please bear in mind, however, that reverberation can cause notes to overlap even 

in monophonic material, creating, in effect, a kind of polyphony. If melodic material is to be edited in 

Melodyne, therefore, you should aim for as clean and “dry” (reverberation-free) a recording as 

possible.

The blobs representing notes in melodic material are displayed at different pitches. Whether the blobs 

are isolated or joined to other blobs depends on the way they were played or sung: staccato or legato.
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The “Melodic” algorithm is predestined for lead vocal tracks, as these are invariably monophonic; for 

there to be polyphony, there would have to be at least two singers. Furthermore, this algorithm takes 

into account the sibilants invariably heard in vocal parts. In the term ‘sibilants’, Melodyne includes not 

only consonants and digraphs such as “s” and “ch”, but also word fragments like “k” and “t” as well as 

the sound of the vocalist inhaling or exhaling between words.

Such sounds, which Melodyne identifies automatically and displays hatched, share one peculiarity in 

nature: There is no way singers can give them a particular pitch, so they remain unaffected by 

melodic changes. This behavior is preserved perfectly by Melodyne’s “Melodic” algorithm: Sibilants 

remain unaltered even when the word or syllable to which they belong is shifted upwards or 

downwards in pitch.

Let’s say the word is “sweet”, and we move the blob that represents the note in question upwards or 

downwards. Whilst the entire note will appear to move, acoustically this will not be the case as the “S” 

at the beginning and the “T” at the end will sound exactly the same after the pitch shift as they did 

before; only the “wee” in the middle will change pitch – in the direction, and by the amount, of the blob 

movement.

When editing timing, too, you will notice that the sibilants (indicated by the hatching) are never 

unnaturally squeezed or stretched.

This intelligent treatment of sibilants is vital to achieving natural-sounding correction of intonation and 

timing. Melodyne even takes into account the borderline cases that occur in nature, where sibilants 

and pitched components are heard simultaneously (rather than successively, as was the case earlier 

with the word “sweet”).

The “Polyphonic” algorithms

In Melodyne, thanks to DNA Direct Note Access, notes can be detected within recordings even of 

polyphonic instruments such as the piano or guitar – including the individual notes of which chords 

are composed. When the Polyphonic algorithms are used, the blobs are displayed in a similar manner 

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
http://www.celemony.com


Melodyne 5 essential - Stand-alone

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 59

to those of monophonic material, with the obvious difference that the blobs are stacked vertically (at 

their respective pitches) whenever a chord or harmonic interval sounds. For example, in the case of a 

chord of E minor, you will see the individual notes E, G and B.

In Melodyne essential and assistant, of course, you can only see the notes of polyphonic instruments, 

displayed as gray blobs. With the editions Melodyne editor and Melodyne studio, on the other hand, 

can you also edit the polyphonic blobs and change, for example, the G of an E minor chord to G# to 

obtain a chord of E major.

But even the gray blobs in Melodyne essential and Melodyne assistant are highly useful, as you can 

use them to discover the chords played by the guitar or the piano and display them in the Chord 

Track. This chord track then provides you with important clues for editing other melodic sound 

sources such as bass guitars or vocals.

Please note, however, that in Melodyne essential and Melodyne assistant a polyphonic instrument is 

never detected  using a polyphonic algorithm. By default, the Universal algorithm, which automatically

allows you to transpose or improve the timing of the material, is used.

If you wish to see the gray, polyphonic blobs, you must choose one of the polyphonic algorithms 

manually. Then work out the chord track before switching back to the Universal algorithm for the track 

in question.

How to switch algorithms is explained below. You will find information on the detection and use of 

chords in the “Chord Detection and the Chord Track” tour.

Your choice between the two polyphonic algorithms should be determined by the type of instrument 

and the playing technique employed:

Polyphonic Sustain is suitable for a wide range of polyphonic audio material in which the 

start of each note does not differ significantly from the rest, as is the case with string 

instruments played legato and organ music.

Polyphonic Decay is a variation of the algorithm designed for instruments or playing 

techniques where the start of each note is markedly different from the rest of it, examples 

being string instruments played pizzicato, guitars and pianos.

Switching algorithms

You can at any time select a different algorithm to that chosen automatically for you by Melodyne. 

You might want to do this, for example, if you find that the material has not been interpreted in a way 

that suits your editing needs. To do this, while playback is halted, select the algorithm you prefer from 

the Algorithm menu. Melodyne will reinterpret the material in the light of your choice and adjust the 

display accordingly.
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Note: when you do this, any editing performed prior to switching algorithms, including any copying of 

notes, will be lost . The right time to decide which algorithm you wish to use, therefore, is before you 

begin editing.

In the plug-in implementation of Melodyne, the choice of algorithm applies per transfer, whereas in 

the stand-alone implementation and an ARA DAW, it applies per audio file in the document being 

edited – collectively, we describe all such material as ‘audio sources’. Before you can change the 

algorithm applied to a particular audio source, you must first select one or more notes belonging 

exclusively to it. If you have selected no notes, or notes from two different audio sources, the 

Algorithm menu will be grayed out. In such cases, reduce your selection to notes belonging to one 

audio source only and it will be possible to switch algorithms.

A special feature of the stand-alone implementation: When you switch algorithms, triggering a fresh 

detection, Melodyne looks at the status of the Auto Stretch switch: if the Auto Stretch function is 

activated, once the new detection is complete, the tempo of the file will also be adjusted: if Auto 

Stretch is not selected, the original tempo of the file will be retained.

Automatic or manual algorithm selection

By default, Melodyne makes its own determination, based on the characteristics of the sound, as to 

which is the best algorithm to apply, distinguishing between these types of material:

Percussive material, in which case the “Percussive” algorithm is selected.

Monophonic melodic material, in which case the “Melodic” algorithm is selected.

Polyphonic material, in which case, depending upon the audio material, either the “Polyphonic 

Decay” or the “Polyphonic Sustain” algorithm is selected.

  Please note, however, that in Melodyne essential and Melodyne assistant a polyphonic instrument is 

never detected  using a polyphonic algorithm. By default, the Universal algorithm, which automatically

allows you to transpose or improve the timing of the material, is used.  

 

If, however, in an instance of the plug-in implementation of Melodyne or in the current document of 

the stand-alone implementation material has already been detected, when new material is transferred 

to that instance or a new file dragged into the stand-alone implementation, Melodyne will use the 

same algorithm for the new material as it used for the old – even if Automatic is selected.

Overruling the Automatic setting in this way is designed to ensure maximum consistency in the 

detection and avoid all risk of one of the transfers from a vocal track suddenly being interpreted as 

percussive. If, however, you have altered the algorithm of a transfer or file manually, the automation 

kicks in again afterwards, and no further attention is paid in the case of further transfers or files to 

already detected material.
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This rule only applies when Automatic is preselected as the algorithm and it does not apply when, in 

the stand-alone implementation of Melodyne, you first drag a file into the document for which you 

have already saved additional information regarding the algorithm and note detection. (From Note 

Assignment mode in the stand-alone implementation of Melodyne, it is possible to store this type of 

assignment data in an audio file.)

By setting a different default via the Algorithm menu, you can prevent Melodyne selecting an 

algorithm automatically for the detection.

Do not forget, however, when you no longer need to impose your choice of algorithm on Melodyne, to 

restore Automatic as the default setting. Otherwise, since Melodyne remembers your default selection 

even after you have quit the program, you might be surprised to discover when the program is next 

launched that your vocals have been interpreted as percussive.

You will find further tips on working with these algorithms in the  section.Melodyne Training
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Note Assignment Mode

Since Melodyne invariably conducts an analysis (we call it “detection”) of the audio material before 

you can do any editing, the correctness or otherwise of this analysis has a considerable influence 

upon how well you are able subsequently to work with the material and how authentic the results of 

your editing will sound. For this reason it is important to check whether Melodyne has identified the 

notes within your material accurately and if necessary correct any mistakes. This where Melodyne’s 

Note Assignment Mode comes in.

What editing the detection involves

When you are working in Note Assignment Mode, none of the changes you make has any audible 

effect on the notes themselves. All you are doing is ensuring that the notes that are displayed do 

actually correspond to those that were played or sung. In other words, you are bringing what you see 

into line with what you hear. In the process, you are working at all times on the display of the original 

recording and, with it, so to speak, on the basis for all musical changes made later with Melodyne. 

The sounder the basis, the better the eventual sound of your edits.

The fact that it is sensible and necessary to check and edit the detection and, with it, the 

interpretation of the audio material may seem tiresome at first sight. But it brings with it enormous 

advantages, for there are often several possible interpretations of the audio material, and which is the 

correct one in a given acoustic and musical context is for you, ultimately, to decide.

But don’t worry. The detection process in Melodyne is mainly automatic and delivers logically 

coherent results. How much there is to edit in this mode depends upon the algorithm used and the 

audio material in question. With a dry recording of a single vocalist, for example, you will very rarely 

encounter problems. It may happen from time to time that a note is detected in the wrong octave, in 

which case, if you later transpose it, it will sound unnatural. Correcting the detection in such cases is 

a task swiftly accomplished. The same goes for percussive material, where it is generally only 

necessary to introduce or remove the occasional note separation.

What is edited and where

Like the choice of algorithm, Note Assignment Mode applies invariably to all the notes of i) a 

particular audio file, ii) a particular recording, or iii) a particular transferred segment – we will use the 

term “audio source” to cover all three. When the Note Editor contains notes from different audio 

sources, begin by selecting a note belonging to the source the detection of which you plan to edit.
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Now click the wrench (spanner) icon next to the toolbox of the Note Editor to activate Note 

Assignment Mode. The background in the Note Editor changes color to show that you are no longer 

in normal Edit Mode but have switched to Note Assignment Mode. In Note Assignment Mode, what 

you see and hear is the original state of the audio source; any editing you may have performed on it 

previously is ignored here.

Any time you click on the blob icon (to the left of the wrench), you will leave Note Assignment Mode 

and return to Edit Mode. There you will hear once again the results of any editing you performed 

before switching to Note Assignment Mode. This only applies, however, if you have not changed 

algorithm in Note Assignment Mode, as any change of algorithm triggers a fresh analysis, and any 

time you trigger a fresh analysis – any time, in other words, the detection process is repeated – all 

editing that has been performed on the notes previously is lost.

Various types of notes

A Melodyne “blob” represents a note, but Melodyne distinguishes between several types of note, and 

it is important – especially when you are working in Note Assignment Mode – to understand the 

difference between them. They are:

active notes

inactive/potential notes

silent notes.

Most blobs represent . These are what Melodyne, having carefully analyzed the active notes

recording, believes to have been the notes (i.e. the fundamentals) that were actually played or sung. 

Active notes correspond to the notes that would be displayed on the sheet music: here a D, here an 

F#, here another D or an A etc. As well as a definite pitch, active notes have a definite length; and 

naturally, you can alter these and other characteristics of the notes in Melodyne.

When the Melodic algorithm is used, only one note can ever be active at a time; that is because this 

algorithm is the one designed for monophonic sound sources (the human voice, say, or an instrument 

such as the clarinet or trumpet that is only capable of playing one note at a time). With the polyphonic 

algorithms, which are designed for instruments like the piano or the guitar that are capable of playing 
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chords, or multiple melodic lines simultaneously, two or more notes can be active at the same time, 

with a separate blob assigned to each. When the audio material has been analyzed using the 

Percussive or Universal algorithms, however, all the notes of a chord are represented by a  single

blob. So it is better, with these two algorithms, to think of a blob as representing a “slice of time” 

rather than a musical note. To illustrate the difference, here we see a guitar chord detected (on the 

left) using the Polyphonic algorithm, and (on the right) using the Percussive one:

From the blobs on the left, you can see exactly which notes comprise the chord. From the “time-slice 

blob” provided by the Universal algorithm, on the other hand, it is impossible to tell which, or even 

how many, notes comprise the chord.

In terms of their editability using the tools, there is not a great deal of difference between the ordinary 

blobs provided by the Polyphonic algorithm and the Universal algorithm’s time-slice blobs – except, 

that is, when it comes to editing chords: When represented by a time-slice blob, a chord can only be 

transposed ; so a chord of F major, for example, could become G major or A major. In other en bloc

words, the intervals  the various notes that make up the chord cannot be changed because between

all the notes hidden behind the (single) time-slice blob move exactly the same distance when the 

chord is shifted upwards or downwards. With the Polyphonic algorithm on the other hand, a separate 

blob is assigned to each of the notes that make up the chord and you can move each blob individually 

– perhaps in a different direction and/or by a different amount to the blobs above or below it. In this 

way you can turn an F major into an F minor – or any other chord you like.

Melodyne’s  form our next category.potential notes
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Represented by outlines (or “hollow silhouettes”), they lie at pitches where Melodyne thought about 

drawing a regular, solid blob, but decided in the end to place this somewhere else, leaving the 

silhouette as a hint at to what might be a possible alternative for that particular note.

So you might consider turning this potential note into a regular note. This, you can only do in Note 

Assignment Mode, so it is only in Note Assignment Mode that you will ever see a hollow silhouette. 

Once you return to normal edit mode, only solid blobs (representing the active notes) appear in the 

display. It should be added that potential notes are only ever encountered with the Melodic or 

Polyphonic algorithms.

Finally, there are what Melodyne calls . These can be seen in both Note Assignment and silent notes

normal Edit Mode, regardless of which algorithm is used to detect the material. A silent note appears 

wherever there is a break between two notes; it corresponds, therefore, to a rest or pause in the 

score.

Like a rest, then, it has a definite length but no pitch, so you cannot transpose silent notes. Their 

length, however, will change if the notes that precede them are shortened or lengthened, or if the 

notes that follow them are moved forwards or backwards in time, in the same way that an eighth note 

(quaver) rest in the score would become a sixteenth note (semiquaver) rest if the preceding note 

were lengthened, or the following note moved forward, by the same amount.

Silent notes are not in fact  silent, because even during breaks between normal notes the entirely

recording continues, picking up things like the hiss of the microphone preamp or the hum of the guitar 

amp, but they are generally far quieter than the notes around them.

Here we see three notes: an active note, followed by a silent one, followed by another active one:
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This illustrates the two significant visual characteristics of the silent note: i) it has no Pitch Curve; and 

ii) it is always placed level with the note to the left of it; if you shift the latter up or down, the silent note 

moves with it, but the change is purely visual; whatever sounds the silent note represents remain 

unaltered.

It is when you come to use the tools in Note Assignment Mode that a clear understanding of the 

nature and behavior of the various types of note found in Melodyne will pay the greatest dividends. 

That is the subject of the next tour. You will also learn there how to transform silent notes into normal 

ones – as well as silhouettes into solid blobs and vice versa, thereby activating and deactivating, 

respectively, the corresponding notes.
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Tools for note assignment

The Main Tool in Note Assignment Mode

In Note Assignment Mode, the toolbox contains tools with functions other than those used in normal 

Edit mode. The most important difference is this: In Note Assignment Mode, the tools have no direct 

or immediate impact on the sound of the notes; their object, rather, is to bring the detected and 

displayed notes as closely as possible into line with the actual music. This makes it possible 

subsequently to edit the material more efficiently and obtain optimal acoustic results.

Which tools are available depends upon the algorithm, as, to a lesser extent, do their functions.

As is the case in normal editing mode, the Main Tool in Note Assignment Mode combines a number 

of the most important functions of the other tools, so as to allow you to perform a variety of common 

tasks without having to change tools.

In the lower part of a blob, the Main Tool functions as the .Activation Tool

In the upper part of a blob, the Main Tool functions as the .Note Separation Tool

We will deal with each of these in turn.

The Activation Tool

The Activation Tool has no function when the Percussive and Universal algorithms are selected. What 

follows, therefore, only applies when either the Melodic or the Percussive Pitched algorithm is 

selected.

If you move the Activation Tool over a blob, its overtone series will be displayed in the background. 

This enables you to see at a glance which of the blobs above it coincide in pitch with the partials of 

the note selected.

In addition to the normal solid blobs used in Melodyne to represent notes, you may see hollow blobs 

of which only the outlines or “silhouettes” are visible. These represent what we call “potential notes” 
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and lie at pitches where Melodyne considered drawing a regular, solid blob, but decided instead to 

place this at a different pitch, leaving the silhouette as a hint that this might be a possible alternative 

for that particular note.

So you might consider turning this potential note into a regular note. This you can only do in Note 

Assignment Mode, so it is only in Note Assignment Mode that you will ever see a blob silhouette. 

Once you return to normal edit mode, only solid blobs (representing the active notes) appear in the 

display. It should be added that potential notes are only ever encountered when the Melodic or 

Polyphonic algorithms are employed.

If you , it will be replaced by a solid blob, indicating that the note in double-click on a silhouette

question has been activated. As soon as you do this, the solid blob vertically aligned with it will be 

replaced by a silhouette, indicating that the corresponding note has been deactivated; this is 

inevitable, since there can never be two notes sounding simultaneously. There can, of course, with 

the larger editions, Melodyne editor and Melodyne studio, which offer algorithms that support 

polyphony, but with the Melodic algorithm, of which we are speaking here, no two notes can ever be 

active at the same time.

If you , you will deactivate it. As no blob would then remain, a silent double-click on a solid blob

note will be created in its place, representing a rest or pause in the music. If you double-click on a 

silent note, the solid blob will reappear, indicating that the original note has been reactivated. Silent 

notes – what distinguishes them, how they arise in nature, and how they behave in normal edit mode 

– are described in greater detail .here

Dragging blobs with the Activation Tool

A double-click is the gesture you will use most often when working with the Activation Tool. It is also 

possible, however, to drag blobs with it, as a means of persuading Melodyne to move the focus of its 

search to a different area. Particularly with material in which pitches are unclear, a new note can (in 

theory) be assigned to almost any pitch in this way, provided Melodyne finds something there. If 

Melodyne finds a plausible destination for the note in the area to which you have dragged it, the blob 

will snap to it; otherwise, it will return to its original position.

Melodyne only considers certain pitches to be plausible. This is one of the strengths of Melodyne: It 

brings to its analysis of the audio material real musical intelligence, and does not therefore 

automatically ascribe every cluster of spectral energy to the presence of a separate note. So, having 

eliminated all the pitches at which the note played could not possibly lie, Melodyne is left with a 

handful of candidates it considers “plausible” and invites you to choose between them.

Recalculation of the pitch center

When you move notes with the Activation Tool, a fresh search for the Pitch Curve within the blob is 

conducted automatically. While conducting the new search, Melodyne also recalculates the pitch 

center of the note. It does this even if you have only moved the blob a very short distance before 

returning it almost immediately to its original position. You can also trigger a recalculation of the pitch 

center by holding down the [Alt] key and double-clicking.
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This is particularly useful when you are importing a file from an older version of Melodyne, as the 

technology Melodyne 5 uses to determine the pitch center of notes is greatly superior to that of earlier 

versions, After the recalculation (most swiftly triggered by holding down the [Alt] key and double-

clicking), the blobs will be realigned slightly on the vertical access – some higher, some lower than 

before – with the results representing the musical content better than those of earlier versions of the 

program. This provides for better results – especially when you are quantizing pitch by double-clicking 

or using the Correct Pitch macro in normal edit mode.

If, on the other hand, the original detection was performed by Melodyne 5 itself, recalculating the pitch 

centers will change nothing, as the results – already optimal – will be no different the second time.

Starting point lines and designated starting points

If, in Note Assignment Mode, you select one of the separation tools, vertical lines appear in the Note 

Editor. At the same time, a slider with two indicators appears next to the toolbox.

We call the vertical lines “starting point lines”. Rising in parallel from their respective blobs to the Time 

Ruler, they show the  that Melodyne has identified in the audio file. A musical starting points

“designated starting point” is indicated by a short vertical line (a “vertical”) topped by an inverted 

triangle and is invariably found near the start of a blob (though not necessarily at its leftmost 

extremity); when active, it indicates what, for the purposes of timing, Melodyne considers to be the 

effective musical starting point of the note. The musical starting point may, but does not necessarily 

have to, be aligned with the separator at the beginning of the note. Think of a brass instrument, for 

example, where each note is often heralded by a certain amount of wind noise. This noise also 

belongs to the note, so it falls to the right of the note separator. What is relevant from the standpoint 

of timing, however – as is the case also with quantization – is the moment when the sound really 

unfolds and the pitch first becomes discernible;  is the timing-critical moment, and it is that later that

instant that is designated the musical starting point. If Melodyne is unable to pinpoint the musical 

starting point of a note, no starting point line is displayed and the note has no designated starting 

point. For the purposes of quantization, the leftmost extremity of the note is then considered to be the 

starting point.
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Each of the longer, starting point lines also culminates in an inverted triangular indicator, which you 

will see just below the Time Ruler. This indicator can be solid, in which case the corresponding 

starting point line is visible and active; or it can be hollow, in which case the line is invisible: we call it 

in this case a “potential” or “inactive” starting point line. An inactive starting point line invariably 

coincides with the beginning of a note. For the note in question, however, Melodyne has been unable 

to discern with sufficient confidence a musically relevant starting point; it is for this reason that the 

starting point line is only a potential one and that no vertical (no designated starting point indicator) is 

displayed at the blob.

The two slider indicators, the Parenthesis and the Ball, govern, respectively, how sensitive Melodyne 

is to the presence of potential starting points and how willing it is to activate them, the result being 

reflected in turn by the total number of triangles displayed and the percentage of these that are solid 

red. As you move the Parenthesis gradually to the right, more and more hollow triangles (indicating 

the presence of “potential” starting points) appear beneath the Time Ruler; this reflects Melodyne’s 

increasing sensitivity that is allowing it to divine more and more points in the material at which a 

starting point  reside – “might” because the lines that are added remain invisible and do not (yet) might

have any effect upon the blobs.

You can alter this, however, with the slider’s second indicator: the Ball. As you move the Ball to the 

right, more and more of the previously invisible, “potential” starting point lines will become active; and 

directly below them, at the level of the blobs, designated starting points will appear at the same time.
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You can activate a potential starting point line by double-clicking on the hollow triangular indicator 

beneath the Time Ruler and, conversely, deactivate an active line by double-clicking on the 

corresponding solid triangle. Double-clicking in a free place in the ruler generates a new starting point 

line.

By dragging its indicator, it is possible to move a starting point line forwards or backwards in time; 

this, however, will seldom be necessary, as Melodyne almost invariably identifies the ideal position. 

You may still wish, though, to do some fine-tuning. If, for the purposes of experiment, you move a 

starting point line from left to right, you will notice that as soon as you pass over the start of a blob, a 

vertical appears complete with inverted triangle (indicating the presence of a designated starting 

point) that follows the line for a while before disappearing as soon as the note begins to decay, as, 

clearly, it would be futile to look any further for the musical starting point.

Starting point lines exhibit a kind of “magnetic” property seen not only when you move them but also 

when separating notes and designating starting points manually.

The Note Separation Tool and the Separation Type Tool

The Note Separation Tool and the Separation Type Tool (directly below it in the toolbar) are available 

with all algorithms and function in the same way as their counterparts in Edit Mode. You can set or 

remove note separations by double-clicking and also move them along the time axis. With the 

Separation Type Tool, you can toggle between hard and soft separations.

By contrast with normal editing mode: In Note Assignment Mode, the separation tools are not used to 

reshape the music but to edit the analysis or “detection”. The object is to ensure that the blobs 

represent as accurately as possible the actual music. Tip: To provide two or more notes of differing 

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
http://www.celemony.com


Melodyne 5 essential - Stand-alone

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 72

pitch with a soft separation, you can select “Convert Selection to Connected Sequence” from the 

context menu (see below).

Since the placing of note separations and the editing of starting points often go hand in hand, you can 

also edit starting points with the Note Separation Tool. Simply move the pointer into the vicinity of the 

triangular starting point markers near the Time Ruler and it changes appearance to resemble the 

Starting Point Tool.

It is possible at any time to deactivate a designated starting point (i.e. withdraw the designation). A 

new starting point can only be designated if an active starting point line is present in a plausible place 

i.e. the left-hand end of a blob. Look for a moment at the starting point indicators: In the relevant 

place, a hollow triangle (indicating the presence of a potential starting point) will probably already be 

displayed. Double-click on the triangle to activate the starting point line.

If no potential starting point line has been identified at the desired position, using the slider near the 

toolbox you can cause additional potential starting point lines to appear: to do this, simply move the 

right-hand control element (the Parenthesis) further to the right.

Alternatively, by double-clicking on an empty area of the ruler at the level of the starting point 

markers, you can create a new starting point line and drag it into position with the mouse. When, with 

the Melodic, Percussive or Universal algorithms selected, you activate a potential starting point line or 

create a new starting point line, a note separation is automatically inserted near a note at the position 

in question.

Tip: When editing starting point lines, if ever you have the feeling that somewhere a note starting 

point exists but that it is not indicated even by a potential starting point line, scrubbing in the relevant 

area often makes it to easier to locate the exact position. At the position in question, a rather loud 

noise component will be audible. Where the noise is loudest, release the mouse button and double-

click to place a starting point line.

The context menu: When you select one of the note separation tools, a context menu appears in the 

Note Editor in which you will find the following commands:

Convert Selection to Connected Sequence: With this command, you can convert a selection 

comprising two or more adjacent notes between which there are hard separations into a 
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connected sequence with soft separations. This is also possible with notes differing in pitch 

and allows you gather together melodic lines to make more coherent editing possible later.

Separate Note: This command separates a note automatically at a point determined by 

Melodyne. It is useful when you need to make precise cuts in a vocal passage and isolate 

sibilants or breathing noise prior to editing using the tools.

Reseparate Notes at Starting Point Lines: This command splits the selected notes at all active 

starting point lines passing through them. It offers you, therefore, a convenient way of inserting 

separations at the same point in multiple notes simultaneously, while removing any 

superfluous separations found elsewhere.

Separate Notes as Trill: The effect of this command is to slice a selection of one or more notes 

into smaller segments determined by the instantaneous pitch of each note. This is done by 

inserting note separations into the slopes of the pitch curve as it rises and falls, thereby turning 

each ‘hill’ and each ‘valley’ of a vibrato into a separate note.

Please note that the fluctuations in the Pitch Curve must be fairly pronounced for the “Separate Notes 

as Trill” function to have any effect and that it is only available when the Melodic algorithm is active, 

being grayed out in every other case. If you wish to assign a shortcut to the command “Separate 

Notes as Trill”, this can be done using the Preferences dialog.

Reset Separations Based on the Selected Grid: This command separates the notes at obvious 

starting points as well as at suitable positions on the selected Time Grid. This command is 

available with the Melodic, Percussive and Universal algorithms.

The Starting Point Tool

The Starting Point Tool is the second sub-tool of the Note Separation Tool.

It is available with all algorithms and is used to designate or undesignate starting points manually by 

double-clicking. A designated starting point is indicated by a vertical (i.e. a short vertical line) with a 

red triangle on top located at or near the leftmost extremity of the blob.
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By moving the Starting Point Tool in the region of the starting point markers beneath the Time Ruler, 

you can also edit these with the Starting Point Tool. As a rule, however, you will generally use the 

Note Separation Tool for this purpose, as described above.
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The Time Grid

The Time Grid slices up the time axis at regular intervals to provide a clearer temporal overview. It 

can also have the function, however, of causing content as it is moved to snap to the nearest grid 

line, thereby making it easier to position notes exactly on the beat. For the spacing of the grid (i.e. the 

distance between adjacent grid lines), you can choose between Seconds and any of a variety of note 

values (half note, quarter note etc.).

Activating and setting the Time Grid

To adjust the Time Grid, either choose Options > Time Grid from the main menu or click the note icon 

(at the top right of the Note Editor) to open the pop-up menu shown here.

Clicking on the note icon activates or deactivates the grid; you can also define a keyboard shortcut for 

this command from the Shortcuts page of the Preferences dialog. If you click the note value or the 

arrow alongside it and hold down the mouse button, the grid menu pops up.

This allows you to the set the interval between grid lines to any of a variety of regular or triplet note 

values or else to Seconds.
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The time axis is then graduated at intervals equivalent to the note value selected. If you have chosen 

a small note value (such as 1/16) and then zoom the display outwards, at a certain point it will 

become impossible to display all the grid lines; the grid value selected, however, will remain active.

Moving notes when the grid is active

When the Time Grid is active and Seconds is not checked, notes moved from one beat to another will 

end up the same distance from the new beat as they were from the old one. In other words, whilst the 

grid does influence their position, they don’t snap exactly to the nearest grid line unless they were on 

a grid line to begin with. The note depicted below, for example, sounds slightly after the first beat of 

the bar.

If, while the grid is active, this is moved to the second beat, there, too, it will sound slightly after the 

beat – the offset in the two cases being identical.

Even if the grid is active, you can still adjust the position of a note (or a selection of notes) 

independently of the grid by holding down the [Alt] key as you move it.
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Chord recognition and the Chord Track

Melodyne is capable of recognizing the chords and detecting changes of key (or ‘tonality’) in your 

recordings. Here you will find all you need to know about Melodyne’s Chord and Key tracks.

Limitations of the editions Melodyne essential and assistant

The chord recognition function is implemented in Melodyne assistant and essential but in those 

editions it is not possible to edit polyphonic material i.e. material in which two or more notes sound 

simultaneously. The procedure is as follows:

Recordings of polyphonic instruments are opened by default in Melodyne assistant and 

essential with the Universal algorithm.

To allow chord recognition, select “Polyphonic” from the Algorithm menu. The notes are now 

displayed polyphonically but in gray, and they cannot be edited using the tools.

You can, however, following the procedure described in the next section, get Melodyne to 

identify the chords formed by these gray notes and display them in the Chord Track.

Once the chords have been identified, you must switch back to the Universal algorithm before 

you can perform any musical editing e.g. transposition or timing quantization.

Triggering the harmonic analysis

To get Melodyne to identify the chords, proceed as follows:

Open the recording of a polyphonic instrument (e.g. piano or guitar). In Melodyne studio, you 

can open multiple tracks simultaneously in the Note Editor (e.g. guitar and bass) so the 

harmonic analysis can take all of them into account.

Display the Chord Track (and the Key Track too, if you wish) by checking the relevant entries 

in the Options menu. Alternatively, you can click on the icons beneath the Time Grid Settings 

menu in the top right-hand corner of the Note Editor.
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Right-click in the Chord Track and select “Analyze Chords” from the context menu. You will 

then see a ‘lead sheet’ of your recording.

Please note: Before optimal results can be obtained from the chord recognition function, the detected 

tempo must be correct; otherwise the chord symbols may be aligned with the wrong beats. Melodyne 

detects the tempo automatically when you load an audio file. If the musical material is particularly 

complex, it may be useful to further optimize the tempo detection. 

We explain how to do this .here

You can repeat the “Analyze Chords” command at any time to update the analysis.

You might do this, for example, after recording a new guitar part containing different chords.

If it’s only certain chords that need to be reexamined, select the chords in question in the 

Chord Track and choose “Analyze Chords”.

To select two or more chords, use the Shift and Cmd keys.

If you click on one chord and then press Cmd+A, all the chords will be selected.

Note: The chord analysis is invariably based on all the notes in selected areas of the Chord Track. It 

is not possible to influence the analysis by selecting or deselecting individual blobs. That would in any 

case make no sense from a musical point of view, as the less information taken into account, the less 

accurately the chords displayed would reflect the overall musical content of the recording.
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There could, however, be cases – if you were analyzing the chords of a complete mix, for example – 

when certain blobs (attributable to the kick drum, say, or the cymbals) might lead to confusion. The 

solution in such cases is to the copy the audio file to a new track, delete the offending blobs, and 

trigger a fresh chord analysis based on that track only.

Selecting between alternative designations

The context (right-click) menu of the Chord Track suggests alternatives for the chords detected:

These, we must stress, are  compositional suggestions, as in “here you could also play this chord”. not

The alternatives suggested are simply alternative interpretations of the audio material.

A chord made up of the notes C, E, G and A, for example, could be interpreted as either C6 or Am7. 

Both interpretations are legitimate, but which is the more apt might depend on the degree to which 

the various notes are emphasized; Does the highest note sound loudly and clearly, for instance, or is 

it barely perceptible? The most appropriate interpretation might depend also on the surrounding 

chords or the prevailing key (or ‘tonality’) of the passage in question. These are questions of content 

but also of taste that are best left for you, the user, to answer. For this reason, Melodyne offers you all 

plausible interpretations and lets you choose between them.

Of course, in the case of very basic chords, there will be fewer alternatives and in some cases only 

one. If the chord, for example, consists of three notes: C, E and G, this can only sensibly be 

interpreted as “C Major”.

Entering chords manually

Independently of the results of the chord detection, you can also fill in the Chord Track manually, by 

typing in the names of the chords or standard chord symbols.

To do this, select an existing chord (a frame will appear, highlighting the chord selected) and type in 

text in the normal way:
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In areas of the Chord Track where no chord symbols are displayed, you can enter them simply by 

double-clicking in the appropriate places and typing them in.

Melodyne accepts all the standard conventions for denoting chords.

For “F minor”, for example, you can spell the chord in any of the following ways: “Fminor”, “Fmin”, 

“Fm” or “F-” (with the “F” in upper or lower case). By default, Melodyne prefers the set language.

You can eliminate specific chord changes by moving the cursor over the borders between chords (the 

cursor than changes its shape) and then double-clicking.

Conversely, you can insert additional chord changes by double-clicking on an existing chord. By 

default when you are inserting or moving chords, they snap to the nearest quarter note (crotchet) on 

the grid. By holding down the Alt key, however, you can temporarily increase the resolution of the grid 

and in this way reach intermediate destinations, an eighth or a sixteenth note to either side.

In the context (right-click) menu of the Chord Track, you can decide whether when you introduce a 

new chord change, a fresh anlysis of the newly created chord halves should take place:

Keyboard shortcuts for editing the chords

The following shortcuts, which are the same as those used for the selection and editing of blobs in the 

Note Editor, allow you more swiftly to enter and edit the chords to be displayed. If you wish, you can 

change the shortcut assignments in the Preferences dialog.

Shift-click and Cmd-click: Extend the chord selection

[Left/Right Arrow]: Select previous/next chord

Shift+[Left/Right Arrow]: Extend selection to include previous/next chord

[Up/Down Arrow]: Switch between alternate chord designations (as described above)
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Cmd+[Up/Down Arrow]: Shift the chord up or down diatonically i.e. using only the notes of the 

current scale, so major intervals are replaced where necessary with minor ones and vice versa 

to suit the key. For example, if the key is A minor and the chord selected is C major. After 

pressing Cmd+[Up Arrow], this will become D minor (not D major, which is not found in the key 

of A minor). If, on the other hand, the key were E minor, selecting a C major followed by Cmd+

[Up Arrow] would produce D major. In this case, the quality of the chord (e.g. the type of triad) 

would not change.

Shift [Up/Down Arrow]: Transpose the chord chromatically upwards without regard to the Cmd

key. So C major becomes C# major, followed by D major, then D# major etc. So the quality of 

the chord does not change: major chords remain major, minor chords remain minor.

By editing the Chord Track in this way, you are not (initially) changing the recorded music. However, 

such changes to the Chord Track will make a difference when you come to edit the notes, if you 

select “Chord” or “Chord Scale” as the Pitch Grid.

Auditioning chords

In the Context (right-click) menu of the Chord Track, you will find an option to audition the chords:

If this option is activated, as you step through the chords with the arrow keys or alter them through 

text input or using the keyboard shortcuts, you will hear the chords in question played with a guitar 

sample.

Chord symbol conventions

Melodyne’s Preferences dialog allows you to choose the chord symbol conventions used in the Chord 

Track. There are various conventions in common use and Melodyne is familiar with all of them. Some 

musicians, for example, write “Cm” to indicate a chord of C minor, whilst others prefer “C-” or “c-”.
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Even though you may have chosen a particular format (e.g. “c-”) for the display, you can still use a 

different convention (e.g. “Cm”) to input the data; Melodyne will simply translate “Cm” into “c-” for you. 

This is particularly useful if you have opted for a convention that involves special characters that are 

awkward to type in. In the Preferences dialog, you could specify, for example, that a chord of F major 

with a major seventh should be displayed as “F#7”, but use a format that is easier to type (such as “F 

maj 7”) when entering chords in the Chord Track.

As well as choosing a naming convention for the display, you can also influence the complexity of the 

chords. For certain musical genres, you may prefer to make the lead sheet easier to read. The 

context (right-click) menu of the Chord Track offers the following options:

Slash Chords

If the guitarist is playing a chord of C major, for example, but the note sounding in the bass is not C 

but G, then – even though this does not change the chord (since the note G does appear in the chord 

of C major) – you may still feel it is important for the notation to take account of this fact using the 

familiar “slash chord” notation: C/G (i.e. C major with a G in the bass). 

If you check this option, this convention will be used throughout the track.

Expanded chords

If you check this option, Melodyne finds expanded chords (such as those common in jazz). If the 

option is cleared, a simpler description will be preferred. For example, if the chord in question is C 

Major but a D is sounding at the same time. D is the ninth of a C major chord, so an exact description 

of the chord would be “Cadd9”. In this case, though, it would be a perfectly legitimate simplification to 

just write “C major” in the lead sheet. This would in any case have no effect (initially) upon the music 

itself. Whether or not this option is checked could have implications, but only on the manner in which 

you edit notes later on. (The editing of the notes in the chord context is dealt with in the next tour).

Less Thirds

Melodyne adds thirds in the course of the chord detection even when none were played, which is 

usually very helpful. But in the blues genre, for example, the musicians often omit thirds on purpose 

and in such cases the addition of thirds is undesirable. If you check this option, the added thirds are 

hidden. Thirds that were actually played, however, remain unaffected and are always shown. If no 

added thirds are present, this option is grayed out.
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MIDI export of the chords as a lead sheet

In the Export dialog, you can select the option “Lead Sheet” in order to save a MIDI file in which the 

chord sequence of your song is displayed in the form of the corresponding MIDI notes.

Typical applications: Transferring the chords to a notation program, or loading the MIDI file into your 

DAW as the starting point for the addition of synthesizer or sampler tracks.

The Key Track and key changes

The methodology for editing the Key Track is basically the same as that just described for the Chord 

Track.

The only real difference is that the context (right-click) menu has fewer entries:

The upper area offers you alternatives to the detected key.

Analyze Key: This triggers a new detection of the key.

Church Modes: Uses the church modes (Dorian, Phrygian etc.)

Open Scale: Opens a separate window to let you select a key.

Conduct New Analysis after Slicing Modes: By double-clicking in the Key Track, you can slice 

an existing segment in two, or merge two segments. This option determines whether or not a 

fresh analysis of the key of the segment or segments involved should be carried out 

automatically whenever you slice or merge segments in this way.
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The Key Track and the Scale Ruler

The Scale Ruler (the left-hand margin of the Note Editor) invariably displays a key, for which 

numerous variations are possible. If your song contains key changes, which scale is displayed will 

depend upon the playback position:
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Chords and keys in Note Assignment Mode

In Note Assignment Mode, you do not see a shared Chord Track for the entire song, as is the case in 

normal Edit Mode, but only the chords played by the instrument you are examining.

For this reason, we speak in the one case of “project chords” that relate to the entire song and in the 

other of “file chords”, which are only visible in Note Assignment Mode and relate only to the 

instrument in question. In the Edit menu, you will find commands that allow you to replace file chords 

with project chords, and vice versa.

It is the same with the keys: The song has a common Key Track (“Project Scale”), whereas what you 

see in Note Assignment Mode in each case is the current “File Scale”.
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The Pitch Grid

You can shift the pitch of notes in Melodyne either continuously or in discrete steps using the grid. 

When the grid is active, notes can only be moved to such pitches as the snap mode selected at the 

time will allow.

The functions of the Pitch Ruler and access to the Pitch Grid

You can change the options relating to the Pitch Grid either from the sub-menu of the same name 

under Options in the main menu or by clicking the clef icon directly above the Pitch Ruler.

Clicking on the Clef icon toggles the grid on and off. When the grid is deactivated, you can slide notes 

continuously upwards or downwards in pitch. Only faint lines in this case separate the notes in the 

Pitch Ruler.

If you click on the Clef icon (or the little arrow next to it) while holding down the mouse key, the menu 

containing the grid options drops down.

The Pitch Grid and the background in the Note Editor

The Pitch Grid, when activated, causes notes to snap to particular pitches as you drag and release 

them. The white horizontal beams beneath the blobs in the Note Editor represent the pitches allowed 

by the currently selected grid. The gray beams represent pitches that are not included in the current 

grid and that the blobs therefore spring over as they are moved.

When you double-click on a blob with the Main Tool or the Pitch Tool, it will snap to the center of the 

nearest white lane – so whether it was perfectly in tune or slightly offset from its previous pitch, its 

offset from its new pitch will be zero. Thus, as well as moving notes to more suitable pitches, a simple 

double-click perfects their intonation at the same time.
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If, on the other hand, you hold down the [Alt] key as you double-click, if a blob was offset 10 cents 

(say) from its previous pitch, it will be offset from its new pitch by the same amount. In other words, 

even though the blob may move to a different pitch, its “degree of imperfection” (in terms of 

intonation) will be preserved – such deviations are, after all, often musically desirable and used 

intentionally in order, for instance, to obtain a warmer, richer tone.

For the Pitch Grid and the background to the blobs in the Note Editor, the following options are 

available:

Pitch Grid

No Snap: The Grid is deactivated and notes can be shifted continuously up or down in pitch.

Chromatic Snap: Notes snap to the nearest note of the chromatic scale.

Key Snap or Chord Snap: Notes snap to the grid currently selected as the display background 

in the Note Editor.

Pitch Background

Keyboard: The background in the Note Editor mimics the pattern of black and white keys on 

the piano keyboard – only in this case, the pitches produced by the black keys are shown in 

gray. When the grid is active, these pitches are inaccessible, so you are effectively locked into 

C Major – which is fine if the song happens to be in that key but not much use otherwise.

Key: Now the notes of the current key or tonality are displayed in white and notes foreign to 

the key in grey. Again, when the grid is active, only the white beams are accessible. If there is 

a change of key in the course of the song, the pattern of white and gray beams will change 

accordingly.

Chord: Now the background pattern changes from chord to chord, with white beams 

representing chord members and notes foreign to the current chord shown in gray. So in the 

case of chords based on simple triads (C Major, F minor etc.), only three notes per octave will 

be available. In the case of more complex chords, more pitches will be available – four per 

octave in the case of a major seventh chord, for example.

Chord Scale: With this option, once again seven white beams per octave are displayed. Unlike 

the case, however, when “Key” was selected, these are not the notes of the current key, but 

instead form a scale that reflects the current chord.

A brief explanation: It is perfectly possible, in jazz for example, for chords to be used that do not fit the 

key, without the listener immediately interpreting this as a key change. For example: You are in C 

major, and the chord played is D major, which does not actually fit the key. If the option “Chord Scale” 
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is selected, for this one chord a black-and-white pattern will be displayed corresponding to the notes 

that fit the chord played within the key. So, in our example, F# would be a legitimate tone and would 

be shown in place of F.

Pitch lines: When this option is selected, a ruled line appears in what was previously the center 

of each beam, and the beams are no longer displayed. The pitch lines invariably reflect the key 

– including any key changes – but not the chords; bold lines indicate the pitch of notes 

belonging to the key; that of notes foreign to it are denoted by thin lines. This display mode is 

useful when you are correcting intonation errors, as the lines show the exact pitches to aim for.

Pitch Labels

Here you can choose whether the names of the notes (C, D, E etc.) or degrees of the scale (I, II, III 

etc.) are shown on the Pitch Ruler.

A practical example

You are perhaps wondering what earthly purpose is served by all these options. An example may 

make things clearer. Let’s suppose you want to import a guitar part from your loop library and adapt it 

to the current song. Here’s how it’s done:

First create a chord track (either by applying the chord recognition function to the instruments 

you already have or by typing in the chords).

Now activate Scale Snap

As the Pitch Background, choose "Chord"

Insert the guitar part from your library and select all its notes (shortcut: [Cmd]+A)

Then double-click any of the selected notes

Now the imported guitar part will follow the chords of the song. You may perhaps want to shift one or 

two of the chords upwards or downwards along the Chord Grid to obtain inversions.

With this procedure, of course, you may find occasionally that two notes that were different in the 

original guitar part end up on the same pitch. This is bound to happen where, for example, in the 

original recording, there’s a major seventh chord (which is made out of 4 notes) but a simple major or 

minor chord (consisting of 3 notes) in the current song. Such problems, however, are easily solved: 

just select one of the two notes and drag it by hand to a “free” white note. Or you could switch the 

display background from “Scale Notes” to “Chord Scale” to obtain a wider choice of suitable notes.

When you are dealing with vocal parts, on the other hand, you will hardly ever find the “Chord” setting 

useful – it would limit the voice to too few notes (often only 3 or perhaps 4 per chord). Choose instead 

“Chord Scale”, which will allow you greater flexibility when working with melodies. Where, on the other 

hand, you have multiple vocal tracks comprised of little more than “Ooh” or “Aah” sounds that you are 

using to provide layers of harmony, then “Chord” might be the most useful setting.

Once you have finished composing the melodic line and begin to address the finer points of 

intonation, switch the display background to Pitch Lines. This is because the lines – which represent 
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perfect intonation – provide a clearer indication of which notes are out tune (and by how much) than 

that provided by the (far broader) beams.

The Scale Ruler and the Reference Pitch Ruler

To select a scale for the Pitch Grid yourself or change other settings, click the rightmost icon (the two 

sharp signs) beneath the Pitch Ruler. Two new columns will appear to the left of it.

Adjusting the master tuning

The narrow column on the very left is the Reference Pitch Ruler. Drag in either direction the mark 

alongside any note – A4, for example – and the Frequency Ruler appears, which you can consult as 

you fine-tune the note in question and, with it, of course, all the other notes of the scale. What you are 

doing here is adjusting the master tuning for the entire Pitch Grid. A tip: increase the vertical zoom 

factor, as this will make it easier for you to locate the value you want.

By right-clicking any of the marks on the ruler, you can open a small context menu. This offers a 

number of pointers to help you bring the Pitch Grid swiftly into line with a particular tuning:
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At the top, you will see the current frequency of the note selected.

Concert: bases the tuning on modern standard concert pitch (where A4 = 440 Hz).

Default: bases the tuning on the frequency currently assigned to A4 in the Preferences dialog.

Detected: bases the tuning on Melodyne’s analysis of the music being edited – the original 

tuning.

Set as Default: tells Melodyne to use the current value as the default tuning for new 

documents and adjusts the value in the Preferences dialog accordingly.

The various settings for A4, incidentally, can be found quickly by clicking the tuning fork icon at the 

top of the Reference Pitch Ruler. By typing into the box immediately below this icon, you can assign 

to A4 any frequency you like.

Selecting the tonic and scale variety

The wider ruler next to the Reference Pitch Ruler is the Scale Ruler. Here you can select the ‘tonic’ (i.

e. the first degree or keynote) of the scale as well as its mode or type. First click on the note you wish 

to use as the tonic. The following menu opens:
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Related scales: in the top part of the menu, you will find a varying number of scales preceded by a “=” 

sign. These are scales that correspond to the current scale but are differently named. Please note 

that when you select a related scale from this menu, only the main structure of the mode in question 

is adopted: the scale is simply given a new name and, if applicable, a new tonic. It can be, however, 

that the exact definition of the related scale in question contains additional secondary degrees or fine-

tuning. If you wish to use these, please choose Open Scale... from the scale drop-down menu.

The current note: in the middle of the submenu, grayed out, you will see the name of the note 

you have clicked on and which you can now make the tonic.

Major / Minor: Allows you to select a major or minor scale with the note selected as tonic. To 

select C Major, for example, click C in the ruler, followed by C Major from the submenu.

Open Scale... : opens Melodyne’s Scale Window, which offers access to a wide variety of 

additional scales. This window will be described in the next section.

Analyzed: this offers you rapid access to two options derived from Melodyne’s analysis of the 

material: the closest major or minor scales and an exact microtonal scale.

Notes Reflect Scale Changes: normally when you change the scale, Melodyne adjusts the 

Pitch Grid but does not change the notes themselves unless you double-click on them first, in 

which case they will snap to the grid. If, however, you wish the notes to adjust automatically to 

any change of scale, select either Tuning or Tuning and Mode. Then any changes will take 

effect immediately and you will hear them at once during playback.

Play Scale: plays the current scale. When this function is active, the loudspeaker icon appears 

above the Scale Ruler. By clicking on this icon, you can deactivate the function without 

needing to access a menu.
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Tip: Initialize the key prior to the transfer/load: In the case of monophonic or polyphonic audio 

material, Melodyne also recognizes the key of the music. With short melodic phrases, however, the 

key chosen is often not the one intended, simply because too few notes are available for a correct 

appraisal. To prevent this happening, you can set the key using the Scale Ruler of an empty instance 

of the plug-in or an empty document (if using the stand-alone implementation of the program)  before

the transfer or loading of an audio file. To do this, simply click on the desired keynote in the Scale 

Ruler and select the desired scale from the context menu. Melodyne will then retain this initialized 

value, regardless of its own subsequent analysis.

The Scale Window

Melodyne’s Scale Window offers a multitude of scales you can select, listen to, and make use of. To 

access this window, choose “Open Scale” from the context menu of the Scale Ruler.

The selected scale applies to all instances of the Melodyne plug-in.

To open the Scale Window, select Open Scale from the context menu of the Scale Ruler.
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Now choose a category from the left-hand pane followed by the desired scale from the pane on the 

right. Click the loudspeaker icon to the right of each entry to hear the scale selected.

If you have activated the option Notes Follow Scale Changes, during playback you will hear 

immediately the effect of applying the scale selected to your audio material. The window allows you to 

try out (or ‘audition’) different scales quickly and easily. If you wish to adopt the changes, exit the 

window with OK; otherwise click Cancel.

From the lower pane of the window, you can select between the parameters of your existing scale 

and those of the scale selected in the Scale Window.

Mode and Tuning: you can adopt either the parameters of your existing scale (on the left) or of 

the scale currently selected in the Scale Window (on the right).

Tonic: you can choose between the selected tonic or the tonic from the preset.

Pitch: here you can choose between current tuning, the pitch from the preset or various 

standard tunings.

Stretching: here you can select whether or not stretched tuning should be applied to the scale.

External Scales Folder...: this button allows you to open a folder containing scale definitions in 

Scala format (filename extension “.scl”) which will then appear as an additional category in the 

Scale Window.

On the Internet, you will find at http://www.huygens-fokker.org/microtonality/scales.html a collection of 

over 4,000 Scala files that you can copy to any part of your hard disk and audition and try out in this 

way using Melodyne.

You can also load scale definitions created in Melodyne studio (filename extension ‘.mts’) with this 

button.
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Selecting notes

In this tour, you will learn which techniques you can use to select notes in Melodyne prior to editing 

them.

Standard selection techniques

Click a note in the Note Editor to select it. Selected notes are more boldly colored.

[Command]-click additional notes to add them to the selection.

[Command]-clicking a selected note removes it from the selection.

 

Another way of selecting multiple blobs is to lasso them by clicking the background in one corner of 

the desired selection and then dragging the pointer to the corner diagonally opposite. This is 

sometimes called rubber-banding. If you hold down the [Command] key, you can add a further rubber-

band selection to the existing one. You can also add individual notes to the selection (or remove them 

from it) by [Command]-clicking.

To select a passage (i.e. a series of notes), click the first note of the series and then [Shift]-click the 

last (or vice versa).
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Snake selection

If you press the [Shift] key, click a note and then move the mouse pointer away, Melodyne’s snake 

selection mode is activated.  You can now add notes to the selection by painting over them with the 

snake.

If you move the mouse (and thereby the snake) backwards again, you can remove notes previously 

painted over from the selection.

Selection using the Pitch Ruler

Click a note in the Pitch Ruler to select notes of the corresponding pitch.

If cycle mode is active, the selection only affects such notes if they lie within the cycle range.
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By [Command]-clicking other notes in the Pitch Ruler, you can add them to the selection and later 

remove them by the same means.

If you double-click, as opposed to single-clicking, a note in the Pitch Ruler, you will select the same 

note in all octaves rather than simply that single instance of the note.

Click and drag in the Pitch Ruler to select a range of notes.

By using the [Command] key in the Pitch Ruler, you can remove from the selection a range of notes 

or individual notes. Here too, if a cycle is active, only notes within the cycle range will be selected.
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Correct Pitch Macro

The Correct Pitch Macro is used to rectify poor intonation quickly and intelligently and rein in any 

undue wavering in pitch. 

Opening and using the macro

Select the notes you wish to edit. If no notes are selected, macro editing will by default affect all notes.

To open the macro, choose Edit > Quantization Macros > Correct Pitch or click on this button at the 

top of the Note Editor.

Here, with the upper slider, you can apply a degree of correction ranging in intensity from 0% (no 

influence) to 100% (full power) to the pitch center of the notes selected. By default, such notes are 

moved towards, or to, the nearest semitone:

If you prefer, however, you can have the notes snap to the nearest degree of the current scale or (if 

chords have already been defined) to the nearest member of the current chord; in either of these 

cases, check the option “Snap to Chord Scale”.

Depending upon the position of the intensity slider, the notes will then snap all, or part of, the way to 

the corresponding pitches.

The macro works in a musically intelligent manner: At lower settings it affects only those notes that 

are wildly out of tune, leaving untouched those that are already quite close to the intended pitch. As 

the slider is moved further towards the right, however, even those notes are influenced, and to an 

increasing degree, until at 100% all the selected notes are exactly in tune.

The pitch center, which the macro adjusts automatically, is the same parameter that is modified when 

pitch correction is performed manually using the Pitch Tool.
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With the lower slider, you can progressively reduce the amount of pitch drift exhibited by the notes in 

question. By “pitch drift”, we mean the kind of slow wavering in pitch that is symptomatic of poor 

technique. More rapid fluctuations in pitch, such as pitch modulation or vibrato, remain unaffected.

You can modify both correction parameters in real time as the audio plays back; and hear, but also 

see (by the movement of the blobs in the Note Editor, the effect of different settings.

If you have already fine-tuned some notes using the Pitch Tool, Melodyne will assume you 

are satisfied with the results; this means that, by default, if you now open the Correct Pitch Macro with 

no notes selected and begin making changes, only the other notes will be affected. By default, in 

other words, notes that have been tuned manually are not affected by the macro. If you wish the pitch 

of these too to be affected by the macro, check ‘Include notes fine-tuned manually’. The option is 

grayed out, of course, as being of no relevance, if no manual editing of intonation has been 

performed.

Closing the macro and correction values when it is reopened

Exit with OK to keep your changes or Cancel to discard them. Naturally the fact that you have used 

the Correct Pitch Macro in no way precludes your fine-tuning notes at any time subsequently by hand.

If you select a note that has already been edited using the macro and then open the macro again, the 

settings previously applied to it will be displayed; the macro remembers, in other words, the 

parameters previously applied to each note. If the current selection includes notes to which different 

settings have been applied, when it is opened the minimum and maximum values for each parameter 

will be displayed.

Even after exiting with OK, you can still reverse the effects of the macro editing by using the undo 

function. 
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The Correct Pitch macro and sibilants

When the algorithm Melodic (the usual choice for vocals) is selected, Melodyne detects and marks 

what it defines broadly as “sibilants”. In the case of vocals, these include not only fricative consonants 

and digraphs such as “s”, “z”, “ch” and “zh”, but also word fragments like “k” and “t”, as well as the 

sound of the vocalist inhaling or exhaling between words. Whilst such sibilants do move upwards or 

downwards in the display under the effects of the macro, acoustically they remain unaltered.

By transposing only the pitched components of the sound in this way, the macro is able to maintain 

optimum sound quality throughout; to alter the frequency of sibilants would sound unnatural. But if, as 

a special effect, you ever do wish to apply pitch shifting to sibilants, this can be done manually using 

the Pitch Tool, as is described in detail .here
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Quantize Time Macro

In this tour, you will learn how to work with the Quantize Time Macro, which makes it possible to 

correct the timing of notes swiftly and effortlessly.

Quantizing timing: What is moved and where to?

Before examining the operation of the Quantize Time Macro, we should clarify a few basic concepts 

and relationships.

Now check Show Intended Notes in the Options > Note Editor sub-menu, which can also be 

accessed via the cog icon in the top right-hand corner of the Note Editor.

Gray boxes now enclose each blob.

When it first analyzes the material, Melodyne calculates for each note two parameters of relevance to 

the process of time correction.

The first is the intended musical beat of the note; this is indicated by the start of the gray frame 

enclosing the blob. As you can see, the start of the frame invariably coincides with a grid line.

The second is either the beginning or the musical starting point of the note, represented, respectively, 

by a note separation or a vertical dash with a triangle. The latter will not necessarily be aligned with 

the left-hand extremity of the blob. Think of a brass instrument, for example, where each actual note 

is often heralded by a certain amount of wind noise. Admittedly this noise belongs to the note, but 

from the standpoint of timing what is of relevance is the moment the sound really unfolds and the 

pitch first becomes discernible; that is the timing-critical moment.

If you quantize notes with the Quantize Time Macro, the musical starting point of each note (if one 

has been determined; if not, the beginning of the note) will move towards the left-hand side of its gray 

frame. The quantization intensity slider determines whether it goes all of the way, or only part of the 

way, to the beat assigned it.
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There are also notes for which no starting point is displayed. Such is the case with notes – and not 

only the human voice but almost all instruments too are capable of producing them – with an attack 

so drawn out that it is impossible to find an instant of which you can say with any confidence “this is 

where the note really begins”. It still begins somewhere, of course, so Melodyne treats the onset of 

the sound – the start of the long attack phase, in other words – as the musical starting point and 

moves that to (or towards) the quantization target – i.e. the beginning of the frame.

In determining, or seeking to determine, the musical starting point of each note, Melodyne conducts a 

careful analysis of the audio material and in most cases its determination is musically correct. Any 

time you disagree, though, you can enter Note Assignment Mode and define some other instant 

within the life of the note as its musical starting point.

The Melodic algorithm requires separate mention because when it is active, Melodyne locates and 

marks what it calls “sibilants”. In the term “sibilants”, Melodyne includes not only fricative consonants 

and digraphs such as “s”, “z”, “ch” and “zh”, but also word fragments like “k” and “t” as well as the 

sound of the vocalist inhaling or exhaling between words. Whenever such a sound coincides with the 

start of a blob, the musical starting point identified by Melodyne always comes later. This produces 

more sensible results when quantization is applied than would be the case if the sibilant itself were 

regarded as the musical starting point of the note.

Another way of changing the way sibilants are handled by the Quantize Time macro is to use the 

Separation Tool to slice the note in two at the point where the sibilant ends; so an “s”, for example, at 

the beginning of a word, would get a blob all to itself. Since an unvoiced “s” can have no musical 

starting point, the left-hand extent of this blob (i.e. the onset of the sound itself) would then be 

regarded as the critical moment for the purposes of quantization.

Opening the Quantize Time Macro and setting the parameters

Select the notes you wish to edit. If no notes are selected, macro editing will by default affect all 

notes. 

To open the Quantize Time Macro, choose Edit > Quantization Macros > Quantize Time or click the 

Quantize Time icon (illustrated here) to the right of the toolbar in the Note Editor.
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First, the Groove Reference (if any) that will govern the time correction must be selected.

If Auto is selected, the target (or ultimate destination) of any quantization will be the left-hand edge of 

the gray frame, as already described. This is invariably aligned with the grid line that represents the 

beat to which Melodyne, in the course of its analysis, assigned the note. (On the whole, the system 

functions very well; but it can happen that Melodyne gets it wrong, and that after 

quantization you have to move the note manually to the preceding or following beat.) By selecting 

Auto, in other words, you are telling the Quantize Time Macro to move notes to (or towards) the beats 

assigned them by Melodyne based on its own analysis of the material.

With the other buttons, you can select the target grid for the quantization. The ‘T’ next to the note 

values stands for the corresponding triplet. If you select 1/4 as the Groove Reference, to give one 

example, the grey frames will move to the nearest quarter-note (or ‘crotchet’) and this will then 

become the ultimate destination for any quantization.

Note that the time correction macro works differently from, and in a more musical fashion than, the 

quantization typically offered by MIDI sequencers. Instead of simply causing all notes to snap to the 

selected grid, it edits the points of rhythmic emphasis of the selected notes. If, for example, you take 

a passage containing successions of sixteenth notes (semiquavers) and quantize it to quarter notes

(crotchets), the beginning of each succession of sixteenth notes will be moved to the nearest quarter 

note. The timing of the semiquavers within the sequence, however, remains unaltered. If you wish to 

tidy that up as well, you can do so in a second pass, taking each semiquaver sequence in turn and 

using sixteenth notes as the quantization factor.

The Intensity slider determines what percentage of the distance to this ultimate destination the notes 

will travel in the course of quantization. If you select 0%, for example, they’ll not budge; 50%, and 
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they’ll go half way; 100%, and they’ll travel the full distance, ending up precisely on the beat. You can 

modify both the Groove Reference and the Intensity of the quantization in real time as the audio plays 

back; and hear, but also see (from the movement of the blobs in the Note Editor), the effect of 

different settings.

If you have already finely adjusted the position of notes using the Timing Tool, Melodyne will assume 

you are satisfied with the results; this means that, by default, if you now open the Quantize Time 

Macro with no notes selected and begin making changes, all notes will be affected except these. If 

you wish the position of these too to be affected by the macro, check ‘Include notes fine-tuned 

manually’. The option is grayed out, of course, as being of no relevance, if no manual editing of note 

positions has been performed.

Closing the macro and correction values on reopening

Exit with OK to keep your changes or Cancel to discard them. Naturally, the fact that you have used 

the Quantize Time Macro in no way precludes your moving notes at any time subsequently by hand.

If you select a note that has already been edited using the macro and then open the macro again, the 

settings previously applied to it will be displayed; the macro remembers, in other words, the 

parameters previously applied to each note. If the current selection includes notes to which different 

settings have been applied, a mean value for each parameter will be displayed.  Even after exiting 

with OK, you can still reverse the effects of the macro editing by using the undo function.
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The Leveling Macro

The Leveling Macro serves to reduce or eliminate excessive volume differentials between the notes 

on a track. It can be used to make quiet notes louder, or loud notes quieter, or both – until, in the 

extreme case, no dynamic variation remains.

Opening and setting the Leveling Macro

First select the notes you wish to edit. If no notes are selected, the macro will govern all the notes on 

the track.

Now open the Leveling Macro either from the Edit menu or by clicking on the icon shown here above 

the Note Editor.

The macro offers you two converging sliders. The left-hand slider, as you move it from left to right, 

makes the quiet notes louder; the right-hand slider, as you move it from right to left, makes the loud 

notes quieter.

When you first open the macro, their positions are as follows;

If you apply maximum leveling, they will then look like this:
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The Mean Amplitude

Coming from the left (quiet) and right (loud), the two sliders as they converge shepherd the blobs 

towards the Mean Amplitude in the center. This value is derived from an analysis of the notes you 

selected before opening the macro. It is therefore based upon the musical content and cannot be 

adjusted manually.

When you use the macro, you will notice that any given note will respond either to one slider or to the 

other. The reason is obvious: a given note’s amplitude in the original audio file cannot be less  and

greater than the Mean Amplitude. Note also that since the ultimate extent of each slider is the Mean 

Amplitude (a line that neither can cross), a note that was originally quieter than the Mean Amplitude 

can never pass above it; and a note that was originally louder than the Mean Amplitude can never 

pass below it.

A further observation: You may notice that certain blobs, representing very quiet sounds that are also 

of very short duration, do not respond to the macro at all. This is deliberate, as Melodyne initially 

assumes the blobs in question represent (extraneous) noise, which if boosted by the left-hand slider 

of the macro would become even more obtrusive. Naturally, you can edit such sounds freely by hand 

using the Amplitude Tool.

If you have adjusted the volume of any of the selected notes manually using the Amplitude Tool 

before opening the macro, it is the adjusted rather than the original values that will be considered 

when calculating the mean amplitude. It is from the most recently set amplitude of the manually 

adjusted notes that any movement towards the centre will begin as the leveling takes effect. If you do 

not wish a manually adjusted note to be affected by the leveling, simply exclude it from the selection 

before opening the macro.

Of course, if you only select one note prior to opening the macro, neither slider will have any effect, 

as in that case the mean amplitude of the selection and the amplitude of the selected note will be 

identical.

Closing the macro and correction values when it is subsequently re-opened

Exit the macro with “OK” to keep your work or with “Cancel” to return to the status quo ante. 

Obviously, you can apply further adjustments later to the volume of the notes in question with the 

Amplitude Tool whether you exit with “OK” or “Cancel”.

Furthermore, even if you exit with “OK”, you can still use the Undo function to nullify the effects of the 

macro. Another way of doing this is to right-click (with the Amplitude Tool selected) and choose 

“Reset Amplitudes” from the context menu.

If you select a note the amplitude of which has already been affected by the macro and then open the 

macro again, the percentage shown in the macro window may differ from that displayed on the 
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previous occasion. This is likely to be the case if the other notes selected are different on each 

occasion, as the mean amplitudes of the two selections will almost certainly differ and, with them, the 

percentage values displayed.
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Main Tool

Melodyne’s Main Tool is context-sensitive, its exact function at any given moment depending upon its 

position relative to the selected blob.

Modifying the pitch and timing of notes

Select the Main Tool (denoted by an arrow) from either the toolbox or the context menu of the Note 

Editor or by pressing the [F1] key of your computer keyboard. (If you wish to assign a different 

shortcut to this tool, you may do so after choosing Melodyne > Preferences > Shortcuts > Editing 

Tools from the main menu.)

With the Main Tool, move the arrow to a point near the center of a blob and press and hold the 

mouse button as you drag it upwards or downwards (to alter its pitch) or left or right (to move it 

forwards or backwards in time). It is the initial movement (whether vertical or horizontal) that decides 

whether the pitch or timing of the note is altered. Before changing axis, you must first release the 

note. If you hold down the [Alt] key as you drag the note, the Pitch Grid or Time Grid, even if active, 

will temporarily be ignored, allowing you to position the note exactly where you want it.

While you are dragging a note up or down, you will hear the frozen sound of the note at the point 

where you clicked. If, whilst dragging, you move the mouse to the right or left, you can put other parts 

of the note under the acoustic microscope. If you do not wish to monitor pitch changes in this way, 

uncheck the option Monitor When Editing Blobs in the Options > Note Editor sub-menu, which can 

also be accessed via the cog icon in the top right-hand corner of the Note Editor.

If you double-click with the Main Tool on the middle part of a note (or on a selection of notes), you 

quantize the note or notes to the nearest pitch allowed by the current Pitch Grid. This offers you a 

quick and simple way of correcting intonation.
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Modifying note lengths

Open the Note Editor Options menu and check Show Blob Info. Zoom in on a few individual blobs, so 

that you can study them more closely. Now, as you move the mouse pointer over a blob, thin lines 

appear indicating the zones in which the Main Tool performs particular functions. For illustrative 

purposes, the lines here have been drawn more boldly than in the program itself. The central area 

you already know about. This has to be distinguished from the front, back and upper regions of the 

blob. As you move the mouse pointer from one of these regions to another, it changes its appearance 

to emulate whichever of the more specialized tools is most appropriate to that zone – adopting its 

functions at the same time.

Drag the front part of a note to the right or left. Hold down the [Alt] key as you do so if you wish to 

override an active time grid. Now only the beginning of the note moves; the end remains anchored, so 

the note is either being stretched or compressed.

In the same way, you can move only the rightmost part of the blob (corresponding to the end of the 

note).

Notice that as you move the beginning or end of a note in this way, the preceding or following note, if 

adjacent, is also either stretched or compressed by the same amount to avoid either the two notes 

overlapping or white space (silence) appearing between them. This type of relationship exists 

whenever a pitch transition between consecutive notes has been detected. By moving the adjacent 

note as well, Melodyne ensures that discontinuities are avoided and the musicality of the phrasing is 

preserved.
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Editing note separations

If you move the mouse pointer to the upper part of a note (above the horizontal line), the Main Tool 

adopts the appearance, and emulates the functions, of the Note Separation Tool. If you double-click 

now, you can create a note separation – i.e. slice the note in two.

Don’t be surprised if the two notes that result move apart in pitch: this is because a new tonal center 

is calculated for each of the newly created notes, and that may differ from the tonal center they 

shared when they were one note. In such cases, each therefore moves to a new vertical position 

based on its newly calculated pitch center.

You can move an existing note separation horizontally with the Note Separation Tool. Before you 

begin, choose Options > Note Editor Options and check Show Note Separations.

You can double-click a note separation to remove it.

If you select several notes and move a note separation, the note separations of the other selected 

notes will also be moved. If you double-click one of the note separations to remove it, those of the 

other selected notes will also be removed.

If you have selected several notes that overlap, you can simultaneously insert a note separation at 

the same point in all of them, as well as move or remove one.
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Copying notes

To copy notes in Melodyne, first select the desired notes, then choose Copy from the Edit menu or 

the context menu of the Note Editor. To insert them, use the Paste command. The following points 

here need to be noted.

The selection, cursor and grid when copying

When you copy notes to the clipboard using the Copy command, you will notice that the cursor 

moves to the start of the selection, or, to be more precise, to the quarter-note (crotchet) on the Time 

Grid closest to the first note of the selection.

If, with the notes still selected, you use the Paste command, all that appears to happen is that the 

notes that were selected prior to the paste are now no longer selected and the cursor is now located 

just after the last of them.

In fact, however, the notes previously selected have been replaced by those on the clipboard. In other 

words, the notes have been copied onto themselves, with the copies replacing the originals. 

Admittedly, this may not sound particularly useful, but look at the position of the cursor: it is now 

aligned with the quarter-note on the Time Grid closest to the last copied note.

If you now execute a further Paste, the notes on the clipboard will be pasted a second time. This time, 

however, since no notes were selected, nothing will be replaced. Instead, the newly pasted notes will 

end up just after those that replaced the originals the first time round.

Their position is now determined by the cursor. And since, after the first paste, this was aligned with a 

quarter-note on the Time Grid (the first quarter-note after the pasted notes, to be specific), the effect 

of the second paste is that the original alignment of the notes relative to the gridlines is reproduced 

exactly, only further along the timeline. This behavior allows you to string together a succession of 

copies of the same passage, quickly and accurately – in order, for example, to create multiple 

iterations of a drum loop.
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Based on what we have just seen, we can formulate the following rules:

If any notes are selected when the Paste command is executed, these are replaced by the 

contents of the clipboard. The pasted notes are stretched or squeezed until they fit exactly the 

range from the beginning of the first to the end of the last note of the selection. This is 

illustrated here: on the left are the notes to be copied; in the centre, a single selected note, 

which serves as the destination of the copy; on the right is the result after the paste is 

performed: The selected destination note has been replaced and the pasted notes squeezed 

just enough for them to fit exactly the space it occupied.

If when the Paste is executed no notes are selected, the cursor determines the point at which 

the pasted passage begins. The grid settings here play an important role: when copying notes 

to the clipboard, Melodyne remembers the distance between the first of the copied notes and 

the nearest grid line. When the paste is repeated at the new cursor position, the offset of the 

first pasted note to the gridline nearest to  will be exactly the same.it

In other words, notes in Melodyne are not copied in such a way that they necessarily coincide with 

gridlines, because then the subtleties of expression would be lost. Instead, the notes copied retain 
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their respective offsets to the grid. There is an exception, however, to this rule: if, instead of being 

calibrated in beats, the grid is calibrated in seconds (i.e. if you have selected “Sec” from the Time 

Grid Settings drop-down menu to the right of the Time Ruler), then the note (or first of a series of 

copied notes) will begin exactly at the cursor position, with no offset.

After each paste, the cursor is moved to the first quarter-note following the most recent paste, 

making it easy to string together multiple iterations of the same passage. Obviously, if you 

wish, you can move the cursor by hand to some other point on the Time Ruler and make that, 

rather than the automatically selected quarter-note, the reference point for the next paste. You 

might want to do this, for instance, to introduce a pause between iterations.

The pitch of the copied notes is always the same as that of the originals. This is even true 

when notes are selected, and therefore replaced, when the paste is performed. The length of 

the passage selected, in this case, is retained but the original pitch of the notes it contained is 

not. Of course, after performing the paste you can move the notes by hand to any pitches you 

like.

Tempo adjustment when copying: the Auto Stretch Switch

If notes are selected when the paste is performed, the inserted passage will be stretched or squeezed 

to fill the available space (i.e. that between the beginning of the first selected note and the end of the 

last) as we have already seen. But how is the tempo of the copied passage treated when the position 

of the paste is determined instead by the cursor?

If the tempo at the destination of the paste is different from that of the passage from which the notes 

were copied, it is the status of the Auto Stretch Switch that determines whether the pasted notes 

adjust to the tempo of the destination or retain their original tempo. If the Auto Stretch Switch is on, 

they adjust; if it is off, they do not. So unless you want to change the tempo at the cursor position, you 

should switch Auto Stretch on before performing the paste.
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Tempo detection and Auto Stretch

Melodyne is capable of recognizing not only the notes but also the prevailing tempos and time 

signatures within a recording.

Introduction

Melodyne’s tempo detection and tempo adjustment functions are used often and to great effect, yet 

they execute for the most part quietly in the background. Example: Drag a recording, a phrase or a 

loop into a document in the stand-alone implementation of Melodyne. Melodyne detects the tempo of 

the music and adjusts it to that of your project (even if this includes gradual tempo changes). The 

audio file runs in sync without your having to give it a moment’s thought.

No tempo detection is performed in two cases:

When an assignment file containing the results of a previous detection and any editing thereof 

has already been saved for the new audio file – here the tempo has been detected already so 

there is no need to repeat the process;

When Apple loops are imported, as these already contain information regarding their tempo – 

here, again, further analysis of the tempo would be pointless.

People often record to a click so that a timing reference will be available later. Often this metronomic 

click is felt to be constraining: Without the click, there is greater freedom and the music that results 

sounds more dynamic and vibrant; it is capable of ‘breathing’.

With Melodyne, you can dispense with the use of a click when recording and still retain a timing 

reference. The trick is simple: Instead of playing to the click resulting in a rigid timeline, with Melodyne 

you can simply adopt the tempo map of the actual recording – with all the minor fluctuations in tempo, 

sudden or gradual tempo changes, and changes in time signature it contains. The music, in other 

words, dictates to the timeline – not the other way around.

Tempo in the stand-alone and plug-in implementations

Melodyne’s tempo detection only plays a role in the stand-alone implementation of the program; not 

in the plug-in. The reason is simple: The plug-in operates within a DAW from which it adopts not only 

the audio material but also all tempo information.

Determining the tempo in the stand-alone implementation

In the stand-alone implementation of Melodyne, with a new document the tempo and time signature 

fields are initially empty; instead of a value in each case a simple dash (“–”) is displayed.
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The Time Ruler, initially, is calibrated in seconds. So you begin with a blank sheet and can either 

enter the tempo and time signature for the Melodyne project manually or allow Melodyne’s tempo 

detection routines to do their work.

To enter the tempo manually, proceed as follows (the default values, unless others are entered by 

hand, are 120 BPM for the tempo, 4/4 for the time signature, and quarter note (crotchet) intervals for 

the Time Grid):

Enter the desired value in beats per minute (BPM) in the tempo field

Enter the desired values for the numerator and denominator of the time signature

Enter a musical note value instead of seconds in the menu for the Time Grid

Click on the button between the time signature and tempo fields in the transport bar to activate 

the metronome. If you are used to working with a DAW, you may prefer to set the tempo 

manually before beginning work on your project. Since Melodyne is extremely good at 

detecting the tempo, it is in many cases easier and more practical simply to allow Melodyne’s 

tempo detection routines to determine the tempo for you.

To allow Melodyne’s tempo detection routines to determine the tempo, proceed as follows:

Instead of initializing the tempo, time signature and Time Grid values manually, as just 

described, begin recording with the tempo and time signature fields empty. Now you no longer 

need a click to listen to as you record because Melodyne will detect the tempo and tempo 

fluctuations within the recording and adjust the grid lines and subsequent click accordingly. 

Instead of entering a numerical value for the tempo, in other words, you are determining the 

tempo through your performance.

Melodyne’s tempo detection routines work in an analogous fashion when, instead of recording, 

you import previously recorded audio. The same condition applies here: you must begin with a 

blank sheet i.e. you must leave the tempo and time signature fields and the Time Grid menu 

untouched. To determine the tempo by means of an audio file, you must load it either by 

choosing File > Import Audio from the main menu or by drag ‘n’ drop. Melodyne will then 

detect the tempo of the file, set the project tempo accordingly and position the file in such a 

way that its musical content begins at Bar 1. As a rule, the first note of the music appears in 

Bar 1, with any silence in the recording that precedes the first note falling in the negative zone 

of the Time Ruler. If the music begins with an anacrusis, however, (i.e. one or more 

unstressed notes that precede the first bar line), Melodyne places this in Bar -1, so that the 

stress falls on the downbeat at the start of Bar 1.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
http://www.celemony.com


Melodyne 5 essential - Stand-alone

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 115

Auto Stretch when importing additional audio files

Once the tempo has been determined, by whichever means, your project will have a tempo map with 

a time signature, an appropriately spaced grid and a tempo curve tracing any fluctuations in tempo it 

contains. The presence of this tempo map introduces new possibilities when additional files are 

imported; possibilities that were not present when we were working with a blank sheet. The Auto 

Stretch Switch, for example, which was grayed out before, now offers you two choices:

With Auto Stretch switched on, every new file imported into the project will be adjusted to 

ensure it conforms to the tempo map in place and replicates any tempo changes it contains. 

To make this possible, Melodyne first analyzes the tempo of the material to be imported and 

then squeezes or stretches it wherever necessary to match the tempo of the project.

With Auto Stretch switched off, no attempt is made to adjust the tempo of the imported file to 

that of the project; so initially, it simply plays back at its original speed. You are perfectly free, 

of course, once the material has been imported, to stretch or squeeze notes to your heart’s 

content as you edit the material. All turning off the Auto Stretch switch does is prevent the 

tempo of the imported file adjusting  to the tempo map of the project.automatically

Where on the Time Grid the file is initially positioned depends upon the procedure used to import it:

If you choose File > Import Audio from the main menu , the physical start of the file (i.e. the 

first sample) will be aligned with the “0:00” seconds mark on the Time Ruler, which may be, 

but is not necessarily, the beginning of Bar 1. If the Auto Stretch Switch is on, the file will 

adjust to the project tempo; otherwise not.

If you import the file by dragging it to a particular point on the Time Ruler (the “dropping point”) 

and Auto Stretch is switched on, the file will be aligned such that the first beat of the first 

complete bar coincides with the dropping point; if Auto Stretch Switch is off, the physical start 

of the file will be aligned with the dropping point. When this procedure is used, the file will snap 

to whichever line on the Time Grid is closest to the dropping point, so your Time Grid setting 

(quarter notes, eighth notes, sixteenth notes…) is of importance here – unless, of course, you 

wish the grid to be disregarded, in which case hold down the [Alt] key as you drag and drop 

the file onto the Time Ruler.

If, instead of a time value, the Time Ruler is calibrated in seconds, the Auto Stretch function is 

automatically disabled; the Auto Stretch Switch is grayed out and no attempt is made to adjust the 

tempo of the imported file to that of the project.
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Auto Stretch when notes are moved or copied

The Auto Stretch Switch plays a role not only when audio is imported but also when notes are moved 

or copied.

If at the destination (i.e. the point to which the notes are moved or pasted) the tempo differs from that 

of the source (i.e. the place from which they are taken), depending upon whether Auto Stretch is 

switched on or off they either adopt the tempo of the destination or retain that of the source. As a 

general rule, before copying or moving notes you will want to switch Auto Stretch on, so that they 

adjust to the tempo of the destination.
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Switching to Melodyne studio trial mode

Explore all the possibilities Melodyne has to offer! To do this, simply switch your Melodyne essential, 

assistant or editor to Melodyne studio trial mode. If you do not have Melodyne, you can download the 

.trial version here

Switching to trial mode

When you switch to trial mode, your Melodyne essential, assistant or editor will be transformed for 30 

days – free of charge and without obligation - into Melodyne studio, the largest Melodyne edition, 

which contains the full range of Melodyne functions. You can use all these functions for 30 days 

without restriction, exactly as if you had purchased Melodyne studio. Trial mode can only be activated 

once on the same computer. To switch to trial mode, and each time you launch Melodyne studio 

during the trial period, you will need an Internet connection.

Here’s how to activate trial mode:

1) Start Melodyne. Next go to the Help menu and select “License”.

In the plugin:

In the stand-alone implementation:

2) You will be directed to your user account in your browser where you will see your license options. 

In the “Melodyne studio trial mode” frame, switch to trial mode:
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That’s all there is to it. Trial mode will remain active for 30 days, so when you return now to Melodyne 

you will see that the “Melodyne studio” edition is running.

Comparing editions

If you wish, you can switch to a smaller edition in the course of the trial period in order to compare the 

range of functions offered by the various editions. This could be useful, for instance, if you own 

Melodyne essential and are wondering which of the larger editions to upgrade to. Easy. Just try them 

all.

To switch editions, select “License” from the Help menu exactly as before. This will take you back to 

your user account in your browser, where you will be given the option of switching to one of the 

smaller editions.

Your choice, however, will only remain effective while Melodyne is actually running. As soon as you 

restart Melodyne, the full Melodyne studio function set will be restored.

Expiry of the trial period

At the end of the 30-day trial period, Melodyne will automatically revert to your previous edition. 

Further editing of projects created during the trial period will still be possible, but only using the 

functions of your previous Melodyne edition. Playback, however, will be unaffected, so none of the 

work you did during the trial period will be lost.

Convinced?

If you wish, you can switch permanently to Melodyne studio at any time during the trial period or 

thereafter. The requisite upgrade can be obtained  or from your local dealer.from our web shop
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Melodyne 5: Update guide

The following is a brief summary of all you need to know to get started with the new Melodyne 5. In 

the individual tours in the Help Center, you will find plenty of exciting tips, tricks and background info 

to read later, but the best place to begin is here.

The Melodic Algorithm with Sibilant Detection

First the good news: You don’t have to do anything; during its initial analysis of the material (the 

‘detection’), the algorithm in its default setting automatically separates the pitched from the unpitched 

(noise-like) components of the sound and thus behaves correctly during the playback. The upshot is 

better sound, pure and simple.

The extent of any noise-like components that have been detected – we call them ‘sibilants’ – is 

indicated by hatching. This is how Melodyne marks not only sibilants proper (“s”, “z”, “ch” and “zh”) 

but also other unvoiced consonants like “k” and “t” as well as the sound of the vocalist inhaling or 

exhaling between words.

If any part of the detection seems strange or incorrect to you, you can switch to Note Assignment 

Mode where you will find the requisite  though doing so is seldom necessary.Correction Tools

When you alter the pitch of a note, Melodyne does not alter the frequency of the sibilants, as that 

would sound unnatural – after all, in real life no singer has the wherewithal to sing one “S” higher than 

another or pitch the sound of their own breathing. In the display, however, the hatched areas do move 

up or down with the rest of the blob when the corresponding note is transposed, but they do this 

solely in the interests of legibility, so that the visual integrity of each syllable is preserved.
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The way changes in the length of notes is implemented in Melodyne now also better represents the 

natural behavior of singers: if a note contains both sibilants and pitched components, the sibilants 

remain unaltered. When time-stretching is applied to the word “sweet”, for example, it becomes “s-

weeeeeeee-t” (not “sss-www-eeeeee-ttt” or anything ghastly like that!).

The case is different where the note in question (or, in this case, the sound to which the blob refers) 

consists  of sibilants and has no pitched components at all, as is often the case with breath solely

noise: this would certainly be shortened to make room for a time-stretched word invading its space. 

But here, too, the principle is the same, because if the rest between two words were shorter, the 

singer would necessarily take a shorter breath. So even when it comes to lengthening or shortening 

breathing sounds, Melodyne 5 automatically achieves a natural effect.

And once they have been isolated, breaths can be stretched or squeezed using a different algorithm, 

with results that sound considerably better than those of earlier versions of Melodyne.

Since, however, sibilants often coincide with pitched components, it can happen that breath sounds 

do sometimes move; when this happens, it is because Melodyne has detected a small pitched 

element in them that has been transposed, and this fact must naturally be reflected in the display. 

This should not surprise you.

All editions of Melodyne profit from these improvements – even the entry-level Melodyne essential.

Compatibility with Melodyne 4

When you open projects that were saved by an earlier version of Melodyne, they sound exactly the 

same in the new version as in the old. This is because when you open old documents, two new 

functions are initially not activated:

Sibilants are not detected.

Pitch centers of notes are still calculated as in Melodyne 4.
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The upshot is that everything sounds exactly as it did before, so if you open your old project today 

with the intention simply of making some minor change to the mix, you do not need to take any 

special precautions.

If, however, you plan to do substantially more work on the project, taking advantage of the new 

features of Melodyne 5, you can do so simply by switching on Sibilant Handling on the vocal tracks. 

This is done by:

placing a checkmark next to the option “Sibilant Handling” in the Algorithm Inspector in Note 

. This will trigger a fresh analysis of the entire track; when this is finished, Assignment Mode

any sibilants will be marked and the playback algorithm will behave accordingly. This may 

change the sound, usually for the better. Please note however that Sibilant Detection is only 

available with the Melodic or the Percussive Pitched algorithm; with all the others, the function 

is grayed out.

Unfortunately, this function is not available with the edition Melodyne essential. If you want to edit an 

old Version 4 project taking advantage of the new sibilant functions, you must trigger a fresh detection 

of the material by clicking the words ‘Melodic’ or ‘Percussive Pitched’ (as appropriate) in the Algorithm 

menu. Please bear in mind, however, that if you do this, all your previous editing will be lost, so it will 

seldom be worth it. Another option would be to upgrade to Melodyne assistant; then not only would 

the entire tool kit be at your disposal but you would also be able to switch Sibilant Handling on and off.

triggering a recalculation of the pitch center of the notes. To do this, you must enter Note 

Assignment Mode and ALT-double-click on the relevant notes. While it is replotting the Pitch 

Curve of each note, Melodyne also recalculates its pitch center. As a result of the improved 

method of determining the pitch center of each note, the blobs may realign themselves slightly 

in the vertical plane, with some moving upwards and others down; the results in either case 

reflect more faithfully the perceived pitch of the notes.

More on the .new way of calculating the pitch center

The Leveling Macro

The new Leveling Macro allows you to rein in volume disparities swiftly. Its effect is to reduce 

differentials between the amplitude of different notes on a track – not only in melodic but also in 

percussive and even polyphonic material.
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The left-hand fader makes the quiet notes louder, whilst the right-hand fader makes the loud notes 

quieter. With both faders set to 100%, all the notes will have the same amplitude.

Whilst this may sound simple, it can accelerate your workflow considerably – particularly in the case 

of polyphonic material, as it allows you swiftly and effortlessly to iron out or reduce disparities 

between the volume levels of different notes within chords.

You can find out more about the Leveling Macro .here

Pitch correction by double-clicking and the Correct Pitch Macro

Whether you double-click on out-of-tune notes to correct intonation errors or use the macro, the new, 

musically weighted calculation of pitch centers delivers better results. Whereas previously you often 

had to fine-tune individual notes manually, even after double-clicking or using the macro, now Select 

All followed by a double-click always results in musically correct intonation. Further editing is now 

required, at most, in a handful of specific genres to steady-up the beginning or ending of words – and 

even this can be performed in Melodyne 5 in next to no time.

More on this....

Both the Correct Pitch macro and double-clicking also profit from the new Chord Track. To an extent 

you can control, and in an extremely musical manner, not only can the intonation of the notes be 

improved swiftly but they can also be transposed simultaneously to fit the chords of the song. This 

allows any instrument track or any sample to accompany any song.

Chord Recognition and the Chord Track

If it is not already visible, click here to show the Chord Track.
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There are now various ways of filling in the chords:

by hand. If you know the chords, you can just type them in. From the Preferences dialog, you 

can choose between various chord naming conventions.

via ARA: If your DAW is equipped with a chord track and makes it available via ARA, 

Melodyne can simply take the chords from the DAW. Any subsequent chord changes you 

make in the DAW will be reflected immediately in Melodyne.

using the Chord Recognition function. If you do not know what the chords of the song are, 

Melodyne can find out for you. Select for the purpose tracks with as much harmonic 

information as possible (e.g. guitar, keyboard or bass) and as little pitch fluctuation as possible 

(so preferably not vocals); do not include drum tracks.

Now right-click on the Chord Track and choose “Analyze Chords”.
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Once the Chord Track has been filled in, you can set the Pitch Grid in the note-editing background to 

reflect the changing harmonies of the song. From this, you can tell at a glance which pitches are, and 

which are not, suitable destinations for notes.

If you now activate the grid by selecting ‘Chord Snap’, whenever you drag and drop notes they will 

snap to pitches consistent with the named chord.
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The same thing will happen whenever you double-click on a note or selection of notes; each note will 

move to the nearest pitch consistent with the named chord. It can happen, of course, that two or more 

notes then come to rest at the same pitch, so it is worth casting a quick eye over the results.

You will find everything relating to chords, the Chord Track and adapting new material to fit the 

chords .here

The new Percussive Pitched Algorithm

With Version 5, Melodyne has acquired a new algorithm. The Percussive Pitched Algorithm combines 

the strengths of two of the existing algorithms.

Like the Percussive algorithm, the new algorithm is optimized acoustically for drums and percussion, 

or – in more general terms – for noise-based material.

In other respects, though, with its display format in which pitches are clearly identified, the Percussive 

Pitched algorithm is more like the existing Melodic algorithm.
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Suitable candidates for the new algorithm are all drum-like instruments that are capable at the same 

time of producing recognizable melodies: an 808 loop, for example, which in addition to the noise-

based snare and hi-hat sounds includes a kick drum tuned to the bass of the song as well as tuned 

toms. A beatboxer track would be another typical candidate for the new algorithm; there, too, melodic 

(bass) with percussive (snare) elements are united in one and the same recording.

More on this....

Keyboard shortcuts

In Melodyne, virtually any function can be controlled using a keyboard shortcut. Experienced 

Melodyne users know how to take advantage of this, and are able to perform tasks considerably more 

swiftly by using shortcuts tailored to their own specific working habits.

To facilitate the handling of keyboard shortcuts, the Shortcuts page of Melodyne 5’s Preferences 

dialog offers a search function that makes creating your own sets of shortcuts easier and more 

intuitive.

You can find out more about keyboard shortcuts .here
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Already own a Melodyne?

If you are already a Melodyne customer and have received a license for Melodyne 5 essential 

bundled with some other software or hardware product, don’t worry; you can use the license in our 

web shop as a coupon when purchasing any other update or upgrade. Here’s how it works:

How does the coupon work?

In our web shop, first place the update for your existing Melodyne or the desired upgrade in your 

shopping cart; then, when you come to pay, enter the serial number of your Melodyne 5 essential as 

your coupon code and click on “Redeem”.
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The coupon has a value of €/US$ 20. This is what you will save if you use the coupon when 

upgrading to a larger edition of Melodyne or when adding a workstation to your existing license. If you 

use it when  from an older version of Melodyne to the current edition, the coupon will save updating

you even more:

Melodyne assistant: with the coupon, the update is free of charge, so you save 49 €/US$

Melodyne editor: with the coupon, the update costs only 29 €/US$, so you save 70 €/US$

Melodyne studio: with the coupon, the update costs only 49 €/US$, so you save 100 €/US$

What if I have already activated my Melodyne 5 essential by mistake?

In that case, you can still use the Melodyne 5 essential serial number as a coupon code. If you do so, 

however, you will no longer be able to reactivate your Melodyne 5 essential, as use of the coupon 

voids the license.

Coupons: terms and conditions of use

Anyone who has received a serial number for Melodyne 5 essential as part of some other product 

bundle can, if he or she is already a Melodyne customer, use this serial number instead on a single 

occasion as a Melodyne coupon in the Celemony web shop. Use of the coupon in this way voids the 

Melodyne 5 essential license.

The coupon is only valid in the Celemony web shop (under www.celemony.com) and only 

when purchasing Melodyne updates or upgrades or when adding an additional workstation to 

an existing Melodyne license. The coupon cannot be used for the purchase of any other 

products. When the coupon is used in the purchase of a product for which it is valid, you will 

be credited with the amount in question, which will therefore be subtracted from the purchase 

price.

The coupon can be redeemed within one year of receipt of the serial/coupon number and in 

any case within three months of the release of Melodyne 6.

Only one coupon can be redeemed per purchase transaction in the Celemony web shop. The 

coupon cannot be exchanged for cash.

The coupon cannot be used in combination with other coupons/discounts and cannot be 

redeemed for purchases already made.
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Version history

Here you will find an overview of all changes introduced by the most recent Melodyne updates.

New in Version 5.4

The update to Version 5.4 contains improvements and bug fixes, which is why we recommend it to all 

users.

Pro Tools and Cubase with ARA: When opening a project with Melodyne, crashes sometimes 

occurred.

Pro Tools with ARA: Deleting a clip from a stereo track with Melodyne ARA during playback 

sometimes led to a crash.

All versions under Windows: In the event of a faulty connection with the Celemony server, a 

crash sometimes occurred.

Studio One with ARA: When using the Fade Tool or closing a session, crashes sometimes 

occurred.

ARA: Opening a second tab after opening the Sound Editor sometimes resulted in either a 

blank user interface or a crash.

Stand-alone implementation: Under macOS, invoking the Undo function during a copy 

operation sometimes led to a crash.

Stand-alone implementation: Crashes sometimes occurred when activating Melodyne.

Stand-alone implementation: The command “Save and Replace Audio” sometimes resulted in 

a crash when the audio file being edited was at the same time being used and played back in 

a DAW.

Trial version of Melodyne: Interrupting activation under Windows sometimes led to a crash.

All versions: In the Japanese user interface, an incorrect localization for “Sibilant Handling” 

was displayed in Note Assignment Mode.

ARA: The ARA mode is now also displayed correctly in the “About Melodyne” window.

Stand-alone implementation: Activating the record-enable function via the track view in the 

Note Editor had no effect on the track pane, where the Record Enable button remained grayed 

out.
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New in Version 5.3.1

The update to Version 5.3.1 contains improvements and bug fixes, which is why we recommend it to 

all users.

Pro Tools with ARA: When repeated use was made of the Undo function in Melodyne, under 

very special circumstances Pro Tools could crash.

ARA and plug-in: Under certain circumstances, not every note was included in local playback.

ARA: When creating a new project, the DAW under certain circumstances displayed an error 

message even though the new project was error-free.

ARA: When you switched back to Edit Mode from Note Assignment Mode, it could happen that 

the display scrolled all the way to the top instead of returning to the previous vertical position.

Studio One: When Studio One was launched, a crash sometimes occurred while the Melodyne 

plug-in was being scanned.

Digital Performer: Under rare circumstances, moving blobs could lead to a crash.

Samplitude: In Melodyne 5.3, it sometimes happened that the ARA files of older projects were 

muted during playback.

Stand-alone implementation: In Note Assignment Mode, execution of the “Convert Selection to 

Connected Sequence” function sometimes led to a crash.

Stand-alone and ARA: On very high-resolution screens under macOS Monterey, crashes 

could occur in Full Screen Mode.

Keyboard shortcuts: The assignments for Track Mode and Clip Mode were erroneously listed 

under “Editing Tools” instead of “View Configuration”, as they are now.

Keyboard shortcuts: The Fade Tool and Sibilant Balance Tool now appear directly beneath the 

Amplitude Tool, which corresponds to the layout in the toolbox.

Note Assignment Mode: Under certain circumstances when you were editing in Note 

Assignment Mode, individual notes were not played back.

Time Handles: When undoing an edit made with the Time Handle Tool, it sometimes 

happened that the sound of the note in question remained unchanged.

ARA: When the Universal algorithm was used, a display error (gaps between the blobs) 

sometimes occurred when blobs were being edited.

http://helpcenter.celemony.com/M5/?lang=en&startPageEdition=melodyne-essential
http://www.celemony.com


Melodyne 5 essential - Stand-alone

   © Celemony Software GmbH 2024 • Last updated on 06/19/2024 • Help Center • www.celemony.com 131

New in Version 5.3

The update to Version 5.3 contains improvements and bug fixes, which is why we recommend it to all 

users. Moreover, Melodyne 5.3 is required for ARA integration into Pro Tools 2022.9.

New features and improvements

Surround: In both ARA and Transfer modes, Melodyne can now also be used for the editing of 

tracks in the standard surround formats.

ARA in Pro Tools: Melodyne 5.3 comes with all the technical prerequisites for ARA integration 

into Pro Tools from Version 2022.9 upwards and thus makes a significantly improved workflow 

in Pro Tools possible.

Preferences: When Melodyne is employed for the first time as a plug-in, it loads the set of 

keyboard shortcuts corresponding to the DAW you are using.

Bug fixes

Recording: In the stand-alone implementation of Melodyne, you can now also use a recording 

device with a mono input (e.g. a MacBook microphone).

ARA in Cubase: When moving an ARA event to a track that is not selected, the selection in 

Melodyne is now retained.

Pro Tools: The position of the playback cursor in Melodyne is now correctly updated even 

when playback is stopped.

AAX in Pro Tools: When bouncing/committing, Melodyne now correctly evaluates the offline 

setting.

The Correct Pitch macro: When the macro was applied to a very large number of notes 

simultaneously, Melodyne would sometimes freeze. This no longer happens.

Preferences: Previously, in ARA mode, the keyboard shortcut for “Playback Selection” was 

erroneously listed under “Others” instead of under “Transport Bar”. This has been fixed.

The Note Inspector: The input field for Sibilant Balance now reliably accepts input even when 

multiple tracks are being edited simultaneously.

ARA in Cakewalk by Bandlab: Under certain circumstances, Melodyne would crash when 

loading a session. This has been fixed.

Ableton Live: The cause of random crashes when Melodyne was running in Live 11.1.1 under 

macOS Monterey on a Mac with an M1 chip has been detected and eliminated.

Note editing: The “Restore Original” commands in the Edit menu now behave more 

consistently in the stand-alone implementation, in the Transfer plug-in and under ARA.

New in Version 5.2

New features and improvements
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Compatibility: In version 5.2, Melodyne now runs natively on Macs with Apple Silicon 

processors. The Mac version is supplied in Universal Binary format with native code for 

processors from Intel/AMD and Apple.

Pitch editing: The scale snap behavior for pitch systems with closely spaced alternate stages 

has been improved.

The playback function: In ARA mode and when using the transfer plug-in, you can now trigger 

playback of the current blob selection using the shortcut Alt+Space. If you would prefer to 

assign a different key combination to this shortcut, you can do so from the Shortcuts page of 

the Preferences dialog.

Cache: The location of Melodyne’s internal cache is now displayed in the Preferences dialog in 

ARA mode too, and you can alter its size.

Bug fixes

Pitch editing: “Monitor When Editing Blobs” now also functions reliably with the arrow keys 

when pitch shifting.

Editing the tempo assignment under certain circumstances led to a crash. Fixed.

Accidentally dragging a track to the Project Inspector tab under certain circumstances led to a 

crash. Fixed.

Changing the pitch reference at high zoom levels under certain circumstances led to a crash. 

Fixed.

Moving an inserted note separation under certain circumstances generated an error message. 

Fixed.

Scale changes: If the “Tuning and Mode” option is active when using “Notes Follow Scale 

Changes”, notes are now moved correctly.

Windows: Melodyne’s file name extension is now correctly assigned.

Melodyne essential: The option “Highlight Notes During Playback” has been added to the 

Options > Note Editor submenu.

Stand-alone mode: When the Replace Audio command has been used, local playback now 

correctly reflects the track selection.

Melodyne essential: The option “Show Fades” that appeared erroneously in the Options menu 

has been removed.

The Note Inspector: When algorithms without sibilant detection are in use, the Sibilant Balance 

parameter is now grayed out.

Selection: When removing a note separation results in two blobs merging, the resulting blob is 

now also selected in ARA mode.

New in Version 5.1.1

Change: A workaround has been integrated for ARA compatibility with Mixcraft 8.

Fixed: Lead sheets are now exported correctly via MIDI.
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Fixed: In Apple Logic, playback can also now be started reliably from Melodyne.

Fixed: Under macOS, shortcuts using the “cmd” and function keys are now displayed correctly.

New in Version 5.1

Features and improvements

macOS 11 Big Sur: Melodyne 5.1 is compatible with macOS 11 Big Sur on Intel-based Macs 

as well as on ARM-based Macs under “Rosetta”.

DAW-oriented keyboard shortcuts: We are always looking for ways to make the operation of 

Melodyne even easier for users of digital audio workstations. That’s why we’ve included sets of 

keyboard shortcuts customized for Pro Tools, Logic, Cubase and Studio One in Version 5.1. 

You can choose the set you want from the Shortcuts page of the Preferences dialog.

Exporting lead sheets: It is now possible to export the contents of the Chord Track as a lead 

sheet via MIDI; you will find the relevant command in the Chord Track’s context menu.

Algorithm selection: During ARA operation with Cakewalk, Melodyne’s Select Algorithm menu 

is now displayed prior to any MIDI export.

ARA improvements: The interaction with ARA DAWs has been optimized in various ways – 

partly to ensure compatibility with future DAW versions.

New keyboard shortcuts: It is now also possible to assign keyboard shortcuts to the following 

commands: “Show Sibilants”, “Note Leveling”, “Copy Song Data to Note Assignment…” and 

“Copy Note Assignment Data to Song…”.

Bug fixes

A keyboard shortcut assigned to “Toggle Cycle Mode” now also works reliably when Melodyne 

is running as a plug-in and under ARA.

MIDI export has been improved and muted notes are no longer included in the export.

Under macOS, keyboard shortcuts using the function keys are now also correctly displayed in 

the menu.

The “Set Cycle to Selection” function now also works correctly in Studio One.

When you stop playback in Pro Tools, the playback cursor in Melodyne now remains where it 

was when playback was halted, instead of springing back to the previous start position.
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New in Version 5.0.2

Bugfix: The installation program no longer launches under Windows 7, displaying instead a 

message saying that Windows 7 is not supported.

Bugfix: In the Note Editor, you can now also place time handles without having to select a note 

first.

Bugfix: In the Note Editor, you can now also move note separations without having to select a 

note first.

Bugfix: In Samplitude X5, when a new audio file is detected, whichever algorithm is selected 

as the default is now used.

Bugfix: There is no longer a delay before newly inserted note separations are displayed in the 

Note Editor.

Bugfix: In Cubase (in Transfer mode, i.e. without ARA), Melodyne still displays correctly even if 

you have changed the size of its window.

Bugfix: During local playback in ARA mode, overlapping notes are no longer erroneously 

played back at the comping boundaries.

New in Version 5.0.1

Bugfix: Use of the “Separate Notes as Trills” command no longer produces occasional artifacts.
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User manuals for older versions

Melodyne studio, editor, assistant and essential 4

The user manuals for Version 4 in English, German, French, Japanese and Spanish as PDFs in ZIP 

archive file format:

Melodyne studio |  |  | Melodyne editor Melodyne assistant Melodyne essential

These versions were replaced in May 2020 by Melodyne 5 studio, editor, assistant and essential.

Melodyne editor, assistant and essential 2 (singletrack)

The user manuals for Version 2 in English, German, French, Japanese and Spanish as PDFs in ZIP 

archive file format:

Melodyne editor |  | Melodyne assistant Melodyne essential

These versions were replaced at the beginning of 2016 by Melodyne 4 editor, assistant and essential.

Melodyne studio 3

The user manual for Melodyne studio 3 is available here in PDF format:

 |  |  |  | English German French Spanish Japanese

This version was replaced at the beginning of 2016 by Melodyne 4 studio.

Ending support for older versions of Melodyne

The following versions of Melodyne are very out of date and no longer compatible with current 

operating systems. For that reason, support for them was discontinued at the end of 2018. It is no 

longer possible, therefore, to download, activate or obtain technical support for these versions of 

Melodyne:

Melodyne studio versions 1 and 2

Melodyne cre8

Melodyne uno

Melodyne plugin

Melodyne essential from a Digidesign or E-mu bundle
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We have, however, provided links to free updates to the latest versions of all the discontinued 

products. If you have one of them and have not already received a notification from us to this effect, 

please contact our support for an update.
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